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section: Introduction

The aim of this course is to introduce you to the concepts of developing
electronic systems using microcontrollers.

In doing so, it offers substantial coverage of Unit 6 of the BTEC Level 3 National

Extended Diploma in Engineering (the precise mapping of the course to this
unit is given on page 9).

On completing this course you will have learned:

e what a microcontroller is.

e how to construct circuits and systems based on microcontrollers.
e how to program microcontrollers.
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Before you start
This course is an introduction to microcontroller programming.
To get the full use out of this course we recommend you have the following:

Flowcode
Flowcode is a software program which allows users to quickly and easily develop complex
electronic systems in a simple manner, it works with a range of microcontrollers, including
Microchip’s ‘PIC’ microcontrollers (PIC MCUs), Arduino, and ARM. Flowcode itself is
microcontroller neutral - it presents virtually the same user interface regardless of the
microcontroller used. The differences are in the hardware and the way the program is
downloaded and tested.

Hardware
It is always more rewarding when learning about microcontroller programming to see the
programs execute on actual hardware, therefore we recommend that you have some hardware

available to send and execute your created programs onto.

This course is mainly designed around the Matrix E-blocks 2 hardware platform, typically the
BLOO11 programmer and the BLO114 Combo board, although separate E-blocks (LCD, switches,

LEDs, etc) can also be used.

E CKS|

BLOO11 pgrammer.

While most of the course is designed around the E-blocks2, we also recognise that some people
may be using either an Arduino or Eblocks1 devices. So in this course, whenever there is change in

the instructions for Eblocks1 or Arduino changes, they will be displayed in the following colours:

Arduino users need an Arduino Uno and E-blocks Arduino Uno Shield (BLO055), as well as the
Combo board.

E-blocks1 users will need the EBO0O6vV9 Multiprogrammer and the EBO83 Combo board plus
connecting wires.
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Getting more Information

Flowcode
http://www.matrixtsl.com/flowcode/support/

From here you can access:
- Flowcode—Getting Started Guide
- Flowcode Wiki
- A wide range of Flowcode examples

E-blocks
http://www.matrixtsl.com/eblocks/resources

In the E-blocks section you can get the follow resources:
- E-blocks USB Drivers
- E-blocks example files
- E-blocks User Guide

http://www.matrixtsl.com/eblocks/boards
From the boards pages:

- Specific datasheets for the boards
- Specific board examples

Other Help

http://www.matrixtsl.com/mmforums/index.php

The Matrix forum provides an in-depth community of well established, long-term users of
Flowcode and new Flowcode users sharing ideas and solving problems and issues encountered
whilst using the software.

http://www.matrixtsl.com/learning/

The Matrix ‘Learning Centre’ contains many different resources including articles, drivers,
curriculum.
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Course Conventions

The following abbreviations are used in the course:

Abbreviation Meaning

ADC Analogue to Digital Converter

ALU Arithmetic Logic Unit

ASCII American Standard Code for Information Interchange
CPU Central Processing Unit

EEPROM Electrically Erasable Programmable Read Only Memory
EPROM Erasable Programmable Read Only Memory
GND ground

Hex hexadecimal

IDC Insulation Displacement Connector

1/0 Input / Output

ISP In-System Programming

JPEG Joint Picture Expert Group (standard for images)
LCD Liquid Crystal Display

LED Light Emitting Diode

LVP Low Voltage Programming

LDR Light Dependent Resistor

LSB Least Significant Bit

MSB Most Significant Bit

NVRAM Non-Volatile Random Access Memory

PIC Peripheral Interface Controller

PROM Programmable Read Only Memory

PSU Power Supply Unit

RAM Random Access Memory

RV1 Resistor-Variable 1

SPI Serial Programmable Interface

XTAL crystal

ZIF Zero Insertion Force

+V positive supply voltage

The following conventions are used:
Matrix products are capitalised on the first word.

Copyright © 2016-18 Matrix Technology Solutions Limited

For example:

Multiprogrammer Prototype board Flowcode

Flowcode menu instructions are presented as:

File > Open

Abbreviations are spelled out in full the first time they are mentioned:
EPROM (Erasable Programmable Read Only Memory)

European circuit symbols are used throughout the course.
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The hardware:

Most exercises use the BL0O011 / BLOO80 Multiprogrammer and BL0114 Combo board.

Most of the exercises can also be completed using the Arduino Uno Shield (BLO055). However,
these require different PORT settings.
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Hardware and software settings used to test most programs:

Hardware jumper settings:

BLO011 / BLO0OSO Jumper settings
Microchip PIC MCU 16F18877
Target voltage 5V J15
Voltage source PSU J11
Programming Source USB J12,13,14: USB
Oscillator Selector 0sC J18,19
Port A E-block E-blocks Combo board
Port B E-block BLO114
Port C E-block
Port D E-block
Port E E-block
Flowcode and download settings:
Menu Name Setting E-blocks 1
Build > Project Options... > Choose a Target Family - PIC 16F18877 16F1937
Clock speed (Hz) 32 000 000 19 660 800
Build > Project Options... > General Options
Simulation speed Normal Normal
Oscillator HS Oscillator HS Oscillator
Build > Project Options... > Configure
Watchdog Timer Enable bit Disabled Disabled
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After completing this course, you will be able to:

01

02
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05
06
07
08

09
10
11
12
13

14

15
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17
18
19

20
21
22
23

24

25
26
27
28
29
30

Introduction

Send different 8-bit codes to ports of the
microcontroller.

Change the logic level of a one single pin.
Configure an output icon.

Use binary code.

Manipulate logic output levels.

Use LED’s to display an output.

Compile a program to the PIC MCU.

Add a delay to slow down execution

of a program.

Change the delay interval.

Configure a delay icon.

Control the speed of a microcontroller.
Use an oscilloscope to time events.

Use Connection Points to introduce
unconditional branching in a program.
Introduce PWM as a means of controlling the
brightness of LEDs.

Create an infinite loop.

Manipulate logic output levels.

Use LEDs to display an output.

Create and use a variable.

Configure a calculation icon to perform
arithmetic and logic calculations.

Create and manipulate variables.
Perform calculations.

Use LEDs with current limiting resistors.
Create and use a ‘running light’ program,
using the ‘multiply-by-two’ method.
Create and use a ‘running light’ program,
using the ‘shift-right’ method.

Create and populate an array.

Create a conditional loop.

Input data from switches.

Use loops to create LED sequences.
Configure an input icon.

Configure decision icons and hence add
conditional branching to a program.

31
32
33
34
35
36
37
38

39
40
41
42

43
44
45

46
47
48
49
50

51
52
53
54
55

56
57
58

59

Objectives

Control the frequency at which LEDs flash.
Use LEDs to display output logic levels.
Use temporary memory.

Create, populate and manipulate string variables.
Control the display of text and numbers on a LCD.
Use a LCD as an output device for the PIC MCU.

Configure a Component macro for the LCD.
Input text and numbers from a keypad and
display messages on the LCD.

Use ASCII code to transmit this data.

Use multiplexed inputs.

Configure a Component macro for the keypad.
Create data loggers, using 8-bit and 10-bit data

from the ADC.

Configure an analogue input.

Enter data via switches.

Enter information from light and
temperature sensors.

Configure and use the EEPROM.

Scroll through EEPROM data.

display text and numerical data on the LCD.
Use the E-blocks prototype board.

Use software macros to simplify the
structure of a program.

Create software macros.

Use closed loop control.

Use PWM to control the brightness of LEDs.
Create and use ‘single-pin’ interrupts.
Create and use ‘interrupt-on-change’
(I0C) interrupts.

Use real time operation of a PIC MCU.
Create and use timer interrupts.

Use the prescaler to create accurate
time intervals.

Trigger the timer using the crystal or an
external event.

(Mapping to Unit 6 of the BTEC Level 3 National Extended Diploma in Engineering is given on page 9).
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Mapping to BTEC Level 3 National Extended Diploma in Engineering

A Investigate typical microcontroller system hardware Covered?
A1l Control hardware
I/0 capabilities — number, type (analogue/digital), ports v
hardware specification — bus width, processor speed v
memory — RAM, ROM v
hardware features - interrupts, PWM v
- stack X
required peripherals v
cost and accessibility o
ease of use o
software and programming language v
operating voltages and power requirements v
A2 Input devices
User input:
digital — switches and buttons v
analogue — control potentiometer v
Temperature
temperature sensors v
environmental sensor — temperature and humidity v
Light
light-dependent resistor (LDR) X
IR — phototransistor, photodiode or IR receiver v
Movement/orientation
| tilt switch X
Presence
micro-switch X
ultrasonic v
Input interfacing requirements
signal conditioning v
analogue-to-digital (ADC) conversion v
modular sensor boards v
PWM v
serial communications v
Inter-Integrated Circuit (12C) v
A3 Output devices
Optoelectronic
light-emitting diode (LED) — indicator and IR v
7-segment display v
liquid crystal display (LCD) v
Electromechanical
relay v
direct current motor v
Servo v
Audio
buzzer or siren X
speaker or piezo transducer X
Output interfacing requirements
power requirements and drivers v
transistor output stage X
relay v
PWM v
serial communications v
12C device interfacing v
A4 Selecting hardware devices and system design
A5 Assembling and operating a microcontroller system
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Mapping to BTEC Level 3 National Extended Diploma in Engineering

B Programming Techniques and Coding
B1 Programming techniques
Use of a programming development environment
software operation v
connecting to microcontroller hardware v
creating and managing program files v
syntax/error checking v
simulation v
compiling, downloading and live testing v
monitoring/debugging .
safe use of computer and display X
Coding practices:
device set-up and program initiation
introductory comments X
chip set-up v
pin modes v
Libraries v
Declarations X
efficient/effective code authoring X
code syntax X
in-line commenting v
code organisation and structure v
B2 Coding constructs
Input/output
digital — bit and port level read/write v
analogue read/write, resolution, calibration v
tone and sound generation X
pulse and PWM v
communication, including serial and 12C v
Program flow and control:
calling libraries v
subroutines and functions v
control structure sequence iteration v
—if, else, switch, case, for, do, while, until and end
delays and timing v
Interrupts v
Logic and arithmetic
variables — data types (Boolean, v
character, byte, integer, word, float, long, double, string)
arrays v
comparative operators: R
=, nots, <, > <or=, >or-=.
Boolean operators — AND, OR, NOT v
logic using input condition v
— digital and analogue
arithmetic operations v
B3 Structured program design
pseudo code v
flowchart v
decision table X
B3 Number systems
bits, bytes v
parallel and serial .
binary to decimal conversion v
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Mapping to BTEC Level 3 National Extended Diploma in Engineering Unit 6

C System development cycle Project
C1 Development processes Project
Stages of the development process.

C2 Documentation Project
A portfolio of evidence produced

throughout the development process.

Key
Symbol | Meaning
v Content covered by the course
. Content partly covered by the course
X Content not covered by the course

Project | Content addressed through project work
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section 1: Introduction to
Microcontrollers

Microcontrollers are tiny devices used to control other electronic devices.
They are found in a huge range of products. In automotive systems they can be
found in engines, anti-lock brakes and climate control systems. In domestic

electronics they can be found in TVs, VCRs, digital cameras, mobile phones, printers,
microwave ovens, dishwashers and washing machines.

A microcontroller is a digital integrated circuit, consisting of a central processing
unit, a memory, input ports and output ports.

Copyright © 2016-18 Matrix Technology Solutions Limited
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Introduction to Microcontrollers Section 1

Microcontrollers

At their heart (or is it brain?) there is a Central Processing Unit (CPU). This processes the digital
signals, does calculations and logic operations, creates time delays, and sets up sequences of
signals.

How does it know what to do? It is following a program of instructions, stored in Section of the
memory, called the program memory, inside the microcontroller.

From time to time, the CPU needs to store data, and then later retrieve it. It uses a different area
of memory, called the data memory to do this.

The clock synchronises the activities of the CPU. It sends a stream of voltage pulses into the CPU
that controls when data is moved around the system and when the instructions in the program
are carried out. The faster the clock, the quicker the microcontroller runs through the program.
Typically, the clock will run at a frequency of 20MHz (twenty million voltage pulses every second).

The Microcontroller

(ngram Memory] ( Data Memory ]

Switch LEDs
Sensor Input Priigizrlw s
Port ) & Port Motor
Unit
Keypad Speaker

( Clock ]

To talk to the outside world, the microcontroller has ports that input or output data in the form of
binary numbers. Each port has a number of connections (often referred to as bits). An 8-bit port
handles an 8-bit (or one byte) number.

Information from sensors is fed into the system through the input port(s). The microcontroller
processes this data and uses it to control devices that are connected to the output port(s). The
ports themselves are complex electronic circuits, not simply a bunch of terminals to hang
components on.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX
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Introduction to Microcontrollors

Microcontrollers—PIC and AVR

The name PIC refers to a popular group of microcontrollers,
produced by Arizona Microchip. AVR is another group of
microcontrollers, also made by Microchip. The microcontroller
on an Arduino board is actually an AVR chip.

When we use a microcontroller, we have to specify how we

Section 1

want the ports to behave. The ports are bi-directional,

meaning that they can act as either input ports or output

ports. When we write a program for a microcontroller, we start by configuring the ports, telling
them whether they are to behave as input ports or output ports.

The input port can receive data (information) in one of two forms, as an analogue signal, or as a
digital signal. It is important that we understand clearly the difference between these.

The Digital World

Much of our everyday information is described in numerical format.

For example:
o "ltis2 o'clock."

e "The temperature outside is 21 degrees C."
e "The car was travelling at 48 kilometres per hour."

It is easy to understand data in this form.

For example, the table shows how the speed of a car changes over a period of time.

Time in seconds | Speed in kilometres per hour
0 0
10 15
20 21
30 25
40 22
50 20
60 16

The Analogue World

Now the information is given in the form of an analogy.

However, you might wonder what
happened at time 35 seconds.

Was the car moving faster or slower
than 25 km/h at that moment?

In other words, we use something that behaves in a similar way.

For example:

1. The hour glass egg timer:
The greater the time elapsed, the deeper the sand in the bottom of the egg timer.

2. The mercury-in-glass thermometer

The hotter it gets, the further the mercury moves up the tube.

3. The car speedometer

The higher the speed, the further the pointer moves around the dial.

The problem with analogue data is that you have to do some work to extract it.

For the speedometer, and thermometer, you have to work out where the pointer sits on the scale.
On the other hand, it is easy to judge how the temperature of a body or speed of a car is changing.

We see the mercury moving along the tube or the pointer moving around the dial.

Copyright © 2016-18 Matrix Technology Solutions Limited
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Introduction to Microcontrollors Section 1

Analogue Data

Many electronic sensors provide signals in analogue form. For example, a 5V .
microphone provides an electrical 'copy' of a sound wave. |
Thermistorﬂ
Another - the temperature sensor.
. . o +———Output
Here is the circuit diagram for one type of temperature sensor.
) ) Resistor |:|
The output voltage increases when the temperature increases.
It is an analogue signal because the voltage copies the behaviour ov
of the temperature.
An electrical analogue signal can have any voltage value,  yjgjtage
limited only by the power supply used. Y3 O
In this case, the output of the temperature sensor could,
in theory, go as high as 5V, or as low as 0OV. B
Over a period of time, the output voltage could change as ]
shown in the diagram. This is an analogue signal. ov >
Time

Digital Data

A digital signal carries its information in the form of a number. Electronic systems usually employ
the binary number system, which uses only the numbers ‘0’ and ‘1’, coded as voltages. We could

decide on the following code: ‘0’ = 0V, ‘1’ = 5V, for example. 5V

Digital signals, then, have only two possible voltage values, usually the

power supply voltage, or as close to it as the system can get, and OV. Push switch b

. . Output
How can we enter these numbers into an electronic system? Hpd
Resistor
One (very slow) way would be to use a switch (an example of a digital
sensor). The circuit diagram shows such a digital sensor. oV

e When the switch is open (not pressed), the output is 'pulled down' to OV by the resistor.
This output could represent the binary number '0'.

e With the switch closed (pressed), the output is connected to the positive supply, 5V in this case.
This could represent the binary number 1.

(Note - if the positions of the switch and resistor were reversed, pressing the switch would put a
logic 0 signal on the pin etc.)
The following diagram shows a more complex digital signal.

Valtage

[
Elllll - —

VT 0 0 1 1 1 0 It

The nine bit binary number represented by the signal is given under the waveform.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX
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Introduction to Microcontrollors Section 1

Analogue to Digital Conversion
Much of our 'real world' data is analogue, but computers (including microcontrollers), only process
digital data. Fortunately microcontrollers often contain a subsystem that can convert information
from analogue format to digital format. This is called an Analogue-to-Digital Converter (usually
shortened to 'ADC' or 'A/D').
The ADC inside a microcontroller divides the range of possible analogue voltages into equal steps.
The lowest step is given the number ‘0’, and the highest step is given the highest number that the
A/D converter can handle.
This highest number is determined by the resolution of the ADC, which, in turn, depends on
number of bits the internal circuitry of the ADC can handle. Typical resolution of microcontroller
ADCs is 8, 10 or 12 bit.

For example, if the biggest analogue voltage is 5V, and a microcontroller has an 8-bit ADC:
the highest 8-bit numberis 1111 1111 (= 255 in decimal).

the first step is 0000 0000 (= 0 in decimal).

meaning that there are 256 voltage levels.

so stepping from one level to the next involves a voltage jump of 5V/256, or about 20mV.

When this microcontroller processes an analogue signal, it first divides it by 20mV, to find out how
many steps the signal includes. This gives the digital equivalent of the analogue signal.
The next graph illustrates this process.

Valtage
inmy
120 l—
100 ’—
%0 | Analogue signal
nalogue signa
60 T g g
40 |7
20 v Digital value
0 :
EBEBEE
g 888 8 8 8| meinm
[ = e | e
§ 3 S|218|8|58
l0/1/2 3 4|5 6| Indecimal |

In our example, the converter outputs 0000 0000 for any analogue signal up to 20mV, outputs
0000 0001 for analogue signals between 20 and 40mV, and so on. The analogue signal shown in
the graph produces an output of 0000 0011.
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Introduction to Microcontrollors Section 1

Inputting data into a Microcontroller

A microcontroller is a digital device, but data can be entered in both analogue and digital forms.
Programmers choose whether pins on the microcontroller are used as analogue inputs, digital in-
puts or digital outputs. This flexibility leads to complex labelling.

*5y

The diagram shows the pinout for a typical MELRiRE= VPP
40pin PIC microcontroller, in this case it is
the 16F1937 chip. It has five ports, known
as A, B, C, D and E. The pins on port A are
labelled RAO to RA7; pins on port B are la-
belled RBO to RB7 etc. Ports A, B, Cand D

have eight pins but port E has only four. e [ VoD —— "

For example, up to eight digital sensors can T —IVES 1
be connected to port A of the 16F1937.

Pin 2 is marked as 'RAO/ANOQ', meaning
that it can be used as bit 0 of port A I
(Register A bit 0) or as ANalogue input 0.

The function of each input / output pin is
determined by setting the contents of in-
ternal registers, called 'data-direction’ reg-
isters inside the microcontroller.

Pins RA6 and RA7 are also labelled as ‘OSC1’ and ‘OSC2’. They can be connected to an external os-
cillator circuit or be used for digital input /output.

Analogue sensors must be attached to the pins labelled with an 'ANx' (ANalogue) label. These,
found on ports A, B and E, can handle analogue signals between Vpp (5V) and Vss (Gnd).

Most pins have alternative functions. For example pin 25 is labelled as 'RC6/TX/CK', meaning that it
can be Register C bit 6, or the transmit (TX) pin of the internal serial interface, or the ClocK pin of
the internal serial interface.

Fortunately Flowcode takes care of the internal settings that dictate pin functionality for you.

Outputting data

The microcontroller is a digital device - we have said that several times already. It outputs a digital
signal. In most cases, we use this to turn something on and off - '0' = 'off' and '1' = '0On’.

For example:

Suppose that we set up port B as the output port (or let Flowcode do it for us). There are eight pins
on port B, so we can switch eight devices on and off. It is important to plan how we connect these
devices, as otherwise they might work the opposite way round.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX
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Introduction to Microcontrollors Section 1

The diagram shows eight LEDs connected to port B of a -

PIC16F84 microcontroller: 1T 17

e The four red LEDs are connected between the
positive supply rail and the port B pins. - v
For these LEDs, the microcontroller is sinking current. "

e The four green LEDs are connected between the pins & 7 ———
and the 0V rail. . ]

For these, the microcontroller is sourcing current.

B

D

“y

. .
Protective resistors

4

Each red LED lights up when its pin is at a low voltage, -
outputting '0' in other words. o

Each green LED lights when its pin is at a high voltage, outputting a '1".

(There are limits as to how much current the ports can control. Typically, one output pin can
manage up to 25mA. This is enough to drive LEDs and buzzers directly, but higher-powered devices
will need additional circuitry to interface with the microcontroller -dealt with later. However, the
maximum current for the whole port is around 100mA, so not all pins can output 25mA at the
same time).

Current Limits

As you have seen, Flowcode has a simulation mode that allows you to attach LEDs to show the
status of the pins on the microcontroller when they are used as outputs. The LED simulation
function inside Flowcode can be set so current is sourced or sinked (look for "polarity" properties
of components which can be "active high" or "active low"), but typically this workbook assumes
that current is sourced from the PIC MCU - like the green LEDs in the diagram above.

At some stage, you will need to use the microcontroller pin specifications in order to use them as
digital inputs, analogue inputs, or as digital outputs. In particular, there are limitations on the
output capabilities of the device. Exceeding these limits, even for a short time, may cause
permanent damage to the microcontroller.

Fortunately the E-block boards used on this Maximum current sunk/sourced by any 1/0O pin 25mA
course all have current limiting resistors which | paximum current sunk by all ports 200mA
protect the microcontrollers. When using the Maximum current sourced by all ports L40mA
prototype or patch boards, however, there is - -

no such protection and care must be taken Maximum current out of VSS (Gnd) pin 9>mA
not to damage your device. Maximum current into Vpp (5V) pin 70mA

Storing Data
Electronic sub-systems that store data are known as

'memory'. They can store only digital data. Address
. . . . . Data stored
One item of data is stored in one location in the memory. This | |y decimal | In binary
data could be the correct combination to dlsa.rm a burglar 0 000 11101001
alarm, or the target temperature of a car engine block.
. . 1 001 00100101
Each memory location has a unique address, a number used
. . . . . 2 010 10000101
to identify the particular location. This means that we can
draw up a map of the memory, showing what data is held in 3 011 11001101
each location (the decimal version of the address is included 4 100 01110100
to make the table easier to read). 5 101 00011011
6 110 11110011
7 111 10000101
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Introduction to Microcontrollors Section 1

Electronic systems only understand binary numbers. This very small memory has eight locations
(notice that numbering normally starts at 0). It needs a 3-bit binary number to create unique
addresses for each location. We can store items of data that are eight bits long (one byte - 1B).
Our example memory could be called a 8 x 1B memory. Memory systems used in computers are
much larger. Data is often stored as 32 bit numbers, allowing the use of much larger numbers.
There are many more locations, too. A typical computer memory now has millions of memory
locations.

Types of Memory
There are several types of electronic memory, each with a slightly different job to do.
We can divide them into two main groups, ROM and RAM.

Read Only Memory (ROM)
These devices are normally only read (i.e. the contents are accessed but not changed / written,)
during the running of a program.
e The contents are not volatile (the data remains stored even when the power supply is switched
off).
e They are often used to store the basic programs, known as operating systems, needed by
computers.
e The group includes:
e PROM (Programmable Read Only Memory)
e EPROM (Erasable Programmable Read Only Memory)
e EEPROM (Electrically Erasable Programmable Read Only Memory)

A PROM is a one-shot device, which arrives blank, ready to receive data. Data can then be 'burned'
into it, but only once. After that it behaves like a ROM chip that can be read many times but not
altered.

With an EPROM, shining ultraviolet light through a window in the top of the chip erases the
contents. New data can then be 'burned' into the memory. Some older microcontrollers operate in
this way.

The EEPROM devices work in a similar way to an EPROM, except that the contents are erased by
sending in a special sequence of electrical signals to selected pins. Flash memory is a form of
EEPROM, widely used as the storage medium in digital cameras (the memory stick) and in home
video games consoles.

Random Access Memory (RAM)
e RAM allows both read and write operations during the running of a program.
e The contents are volatile and disappear as soon as the power supply is removed.
(The exception is NVRAM, Non-Volatile RAM, where the memory device may include a battery
to retain the contents, or may include an EEPROM chip as Section of the memory to store the
contents during power loss).
e They are often used for the temporary storage of data or application programs.
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Microcontroller Memory

Introduction to Microcontrollors Section 1

Microcontrollers have three separate areas of memory: Flash
e program memory (Flash) 1024
: :Iszle;;\g“r,llable memory (RAM) program
memory
The names give strong hints as to the purpose of the areas. locations
For the eighteen pin PIC16F84 the graphic illustrates the
organisation of the memory. Program Memory
RAM EEPROM
Program memory is used to store the program. 68 64
In most microcontrollers, such as the 16F1937, this uses
Flash technology, meaning that it can be programmed and general general
cleared many times. Older PIC MCUs use PROM for the merr!nry merr!ory
locations locations
program memory so that many of these can be
programmed only once. Data Memory

Data memory is used to store data.

Section of this uses RAM and Section uses EEPROM.
The EEPROM allows us to preserve important data
even if the power supply to the system is switched off.

For example, suppose that the microcontroller is used as a temperature controller that keeps an
incubator at a set temperature. It might make sense to store the target temperature value in
EEPROM so that we do not have to enter it into the system every time we switch the incubator on.

Programming

Microcontrollers are programmable devices. They do exactly what they are told to do by the
program, and nothing else. A program is a list of instructions, along with any data needed to carry
them out.

The only thing microprocessors understand is numbers. There's a problem because we don't speak

in numbers, and they don't understand English.

There are two solutions, and both need some form of translator:

e \Write the program in English, or something close to it, and then have the result translated into
numbers.

e We can think through the program design in English and then translate it ourselves into a
language that is similar to numbers, known as assembler. From there, it is a swift and simple
step to convert into the numerical code that the microcontroller understands.

These two extremes are known as programming in a high-level language (something close to

English) or in a low-level language (assembler).

The first is usually quicker and easier for the programmer, but takes longer to run the program,

because of the need to translate it for the microcontroller.

The second is much slower for the programmer, but ends up running very quickly on the

microcontroller.
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Introduction to Microcontrollors Section 1

The Flowcode Process

Flowcode offers an easy way to program microcontrollers, as you will see. Once the flowchart is
designed on-screen, one press of a button causes the software to translate it into numerical code.

Flowcode passes the program through a number of processes before it gets sent into the
microcontroller. The flowchart is processed:

e firstinto C code,
e then into Assembler,
¢ and finally into hexadecimal numbers or 'Hex', which the microcontroller 'understands'.

The Hex code is then sent into the microcontroller, using a subsidiary program called 'Mloader'.
When you select Build > Project Options... Configure from the Flowcode menu, you can control a
number of options and configurations by setting the value of registers inside the device when you
download a program.

FLOWCODE]| .j
LT
< c l
Bl .

clear_bit{intcon, 2); Assembly
FCM_INTERRUPT_TMR
o)

moviw D'7*

bsf STATUS, RPO

bef STATUS, RP1 Hex
movwl _adooni

moviw D'192

movwf option reg :040000008A01122837

:08000800F DOOFODEOSD
EF10000
:10001000040EF2000A0
EF3008A110A122928352
B6C
:10002000D928FE28073

L

Mloader

Send program
{Check crystal
setting)

The Hex code is 'burned' into the microcontroller program memory. Since Flash memory is used to
form the program memory, the program is not lost when the microcontroller is removed from the

programmer. This allows you to use it in a circuit. Equally, use of Flash memory means that you can
reuse the microcontroller and overwrite the program memory with a new program.

Running the Program
As soon as the microcontroller is powered up and is supplied with clock pulses, it will start to run
whatever program is stored in program memory (Flash).
When you press the reset button on the microcontroller programming board, the program restarts
from the beginning.
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Introduction to Microcontrollors

Section 1

During programming the microcontroller stops while the program is being loaded. When that is
completed, it then restarts and runs the downloaded program.

Different types of Microcontroller

There are a large number of microcontroller devices available, from the humble 16F84 to larger
more complex microcontrollers such as the 40 pin 16F1937. Different microcontrollers have
different numbers of ports, or I/O pins, analogue inputs, larger memory, or advanced serial
communications capabilities such as R$232 or SPI bus.

PIC16F18877 Architecture

As an example we will use the 16F18877 microcontroller. It is important that you understand a
little more about what it does and how to use it. This section details the pins that are available on

the 16F18877 and the connectors they use on the E-blocks programmer board.

At this point in a traditional programming course, you would be introduced in some detail to the
various internal circuit blocks of the microcontroller. You would need this information to write
code for the microcontroller in C or assembly code.

No need - Flowcode takes care of these details.

However, you do need to understand the input
output connections of the microcontroller, the
memory available and the role of the other
subsystems in the microcontroller.

and

Ports - The 16F18877 has five ports, labelled ‘A’ to
‘E’, connected to the rest of the microcontroller

internals by an 8-bit bus system.

PORT A

PORT B

PORT C

PORTE

I
FLASH-TYPE RAM-TYPE
PROGRAM MEMORY DATA MEMORY -
EEPROM-TYPE
TELLS THE AL WHAT TQ DO ALL THE DATA MEMORY
VARIABLES WILL

THE PROGRAM YOU WRITE BE STORED Lotk
COMES IN HERE HERE PERMANENTLY

8192 lines of 14 BIT WIDE 512 lines of 8 BIT 256 lines of 8 BIT

System ::It:z:ltI

Clock from external oscillator

osc1 [
oscz [&]

T1CKI

IMON OHIYIN
1HOd 1HVLS

START TMR1 START TMROD
MACRO NOWT! MACRO NOWI

NS
ALU

IMON OHOWIN
08y LHVLS

oo

10- BITS = 10 LEB of INTEGER

4-MSE BITS =BYTE

[TTTTTTTTT]
AIG 10-BIT REGISTER

(1911
azzzezaz:
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PORT D

RAD/AND
RAA/ANA
RAZIANZ
RA3IAN3
RA4ITOCKI
RAS/AN4
RAB/OSC2
RA7/OSC1

RBO/INTIAN12
REAVANTY
RB2/ANS
RB3TANS
RB4/ANT1
RB5/ANT
RB&

RB7

RCOTICKI
RC1/CCP2

RC2/CCP1

RC3

RC4

RCS

RC&

RC7

RDO
RD1
RD2
RD3
RD4
RDS5
RD6&
RD7

REQ/ANS
RE1/ANG
RE2/ANT
RE3/MCLR
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Introduction to Microcontrollors Section 1

16F18877 Microcontroller

Layout:
16F1887T7
RE3/MCLR RBF/ANTS
RANAND RB&/ANT4
RA1ANT RBS/ANT3
RAZIANZ RB4/AN1IZ
RAJANI RB3/AN1
RAdiand RB2/AN10
RASIANS RBAJANG
REMANIZ RBO/ANS
RE1/AN33 oo
RE2Z/AN34 WSS
VoD ROF/ANI
V5SS RDS/AN30
RATIANT RDS/ANZES
RABIANS RD&/ANZE
RCOMAN1G RC7/IANZS
RC1AANT RCE/MANZ2
RC2IAN1E RCS/ANZ1
RCIANIS RC4/AN20
ROOFANZ4 RO3/ANZT
RO1/ANZS RD2/ANZE
Memory
Flash
e Flash memory is used to store the program you write.
e This program is 'compiled' by the computer to binary code and then
downloaded into the Flash memory of the microcontroller.
e You can read from, and write to it and it is retained, even after a power cut.
e The Flash memory contained in the 16F18877 can store up to 32768 program
commands.
RAM

e Data from inputs, outputs, analogue inputs, calculations etc. is typically stored in
‘variables’ (values in the program that alter as it runs). RAM is where these are stored.

e This memory is erased every time the power gets cut or a reset occurs.

e It also contains system 'registers' which control and report the status of the device.

e The RAM memory in the 16F18877 can store up to 4096 bytes of data.

EEPROM

e EEPROM is where data can be permanently stored

e This memory is of the PROM-type - preserved every time the power cuts or a reset
occurs.

e The EEPROM of the 16F18877 can store up to 256 bytes of data.
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Introduction to Microcontrollors Section 1

ALU

The ALU (Arithmetic Logic Unit) is at the heart of the microcontroller’s data processing.

All data passes through this unit.

The program in the Flash memory tells the ALU what to do.

The ALU can send data to, and fetch data from all the separate blocks and ports in the
microcontroller using the 8-bit wide data-bus.

The ALU needs four external oscillator clock pulses to execute one whole instruction.

How the ALU works is very complicated. Fortunately Flowcode programmers do not need to
know how it works.

Timer 1 (TMR1)

This timer interrupt is used to provide the microcontroller with exact timing information.

It is ‘clocked’ either by the system clock or by an external clock on pin RCO.

Either clock can be divided by 1, 2, 4 or 8 by configuring the Prescaler of TMR1 in Flowcode.
The resulting output triggers TMR1 and increments the TMR1 register.

TMR1 is a 16-bit register, which ‘overflows’” when it reaches ‘65536’.

At the instant it overflows, it generates an interrupt and the TMR1 register is reset to ‘0.

This TMR1 Interrupt stops the main program immediately and makes it jump to the TMR1
macro.

After this finishes, the main program continues from where it left off just before the interrupt.

For example:
External clock oscillator frequency (crystal oscillator) 19 660 800 Hz
System Clock (four clock pulses per instruction) 4915 200 Hz
Set prescaler to ‘8’ (divides by 8) 614 400 Hz
Overflow frequency when TMR1 = ‘65536’ 9.375 Hz

Result: TMR1 interrupts the main program and execute the TMR1 macro 9.375 times per second.

Timer 0 (TMRO)

This timer interrupt also provides the microcontroller with exact timing information.

It is ‘clocked’ either by the system clock or by an external clock on pin RA4.

This system clock runs exactly four times slower than the external oscillator clock.

Either clock can be divided by 1, 2, 4 or 8, 16, 32, 64, 128, or 256 by configuring the Prescaler of
TMRO in Flowcode. The result triggers TMRO and increment the TMRO register.

e This TMRO register is an 8-bit register, which overflows when it reaches 256.
e At theinstant it overflows, it generates an interrupt and the TMRO register is reset to 0.
e A TMRO Interrupt stops the main program immediately and makes it jump to the TMRO macro.
e After this finishes, the main program continues from where it left off just before the interrupt.
For example:

External clock oscillator frequency (crystal oscillator) 19 660 800 Hz

System Clock (4 clock pulses per instruction) 4915 200 Hz

Set prescaler to 256 (divides by 256) 19 200 Hz

Overflow when TMRO = 256 75 Hz

Result: TMRO interrupts the main program and execute the TMRO macro 75 times per second.
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RBO External Interrupt

e Alogic level change on pin RBO can be configured to generate an interrupt.
e |t can be configured in Flowcode to react to a rising or to a falling edge on RBO.
e If set to react to arising edge, when one occurs:
e it immediately stops the main program;
e the RBO related macro is executed;
e then the main program continues from where it left off just before the interrupt.

This happens every time a rising edge is detected at pin RBO.

PORT B External Interrupt

A/D

e Alogic level change on any combination of pins on port B can generate an interrupt.
e This can be configured to occur on a rising or a falling edge, or both.
e When one of these interrupts occurs:
e it immediately stops the main program;
e the port B related macro is executed;
e then the main program continues from where it left off just before the interrupt.

This happens every time a level change is detected on one of the pins selected on port B.

The 16F18877 has 35 pins.

It has only one 10-bit A/D converter.

This implies that these fourteen analogue inputs can't all be read at the same time.

A built-in analogue switch, configured in Flowcode, selects which inputs are sampled.

After the sample instruction, the analogue switch points to the correct input and this is

converted into a 10-bit binary value.

¢ In Flowcode, you can opt to use only the eight most-significant bits (MSB's) of this 10-bit value,
by using the GetByte instruction, or to use the full ten bits by using the GetlInt instruction. The
ten bits will fill up the ten least-significant bits (LSB's) of the selected 16-bit integer variable.

e After this, the program can select to read another analogue input.

Busses

A PIC and AVR microcontrollers are based on a Harvard architecture.

This means that there are separate busses for instructions and for data.

The data bus is 8-bits wide and connects every block and port together.

The instruction bus is 14-bits wide and transports instructions, which are 14-bits long, from the
program memory to the ALU.

Introduction to ‘clocks’

Every microcontroller needs a clock signal to operate. Internally, the clock signal controls the speed
of operation and synchronises the operation of the various internal hardware blocks.

In general, microcontrollers can be ‘clocked’ in several ways, using:

e an external crystal oscillator.

e ‘RC’ mode, where the clock frequency depends on an external resistor and capacitor.

e aninternal oscillator.

The ‘RC’ mode exists partly historical and partly for reasons of economics. It was introduced as a
low cost alternative to a crystal oscillator. It is fine for applications that are not timing critical, but is
not covered in this course.
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Section2: Using
E-blocks

E-blocks are small circuit boards that can easily connect together to form an
electronic system. There are two kinds of E-Blocks. Upstream boards and
Downstream boards.

A variety of boards can be combined to create a full system with downstream boards
connected to upstream boards.

E-blocks are ideal companions to Flowcode software, allowing users to test and
develop their Flowcode programs. Programs can be compiled directly to the boards,
providing ideal development environments.
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Using E-Blocks Section 2

E-blocks consist of upstream boards and downstream boards.

Upstream boards

'Upstream’ is a computing term indicating a board that controls the flow of information in a
system. They are usually programmed in some way.

Any device which contains 'intelligence' and can dictate the direction of flow of information on the
bus can be thought of as an 'upstream' device.

Examples include microcontroller boards, and Programmable Logic Device boards.

Downstream boards

‘Downstream’ boards are controlled by an ‘upstream’ board, but information can flow into or out
of them. Examples include LED boards, LCD boards, RS232 boards etc.

)

Upstream and downstream boards combined to form a full system, with the downstream boards
plugging into the upstream ‘intelligent’ boards:
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BLOO11 PIC Programmer

The board has five ports, labelled A to E.

Ports ‘B, ‘C’ and ‘D’ offer full 8-bit functionality.

Port ‘A’ has 6-bit functionality (8-bit if the internal oscillator is selected).

Port ‘E’ has 3-bit functionality.

It can be powered from an external power supply, delivering 7.5V to 9V or from a USB supply.
If the Reset switch is pressed, the program stored in the microcontroller will restart.

The board is USB programmable via a programming chip. This takes care of communication
between Flowcode and the microcontroller.

The microcontroller executes one instruction for every four clock pulses it receives.

(Note - a single instruction is NOT the same as a single Flowcode symbol, which is compiled into C
and then into Assembly and probably results in a number of instructions).

This course uses an 8MHz crystal which is multiplied up to 32Mhz internally.

Switches allow the user to select a number of options.

External power supply or USB power supply.

Where the microcontroller uses an internal oscillator, all eight bits of port A can be used for I/O
operation.

Use of a PICKit3 tool from Microchip via ICSP header.

Comes with a surface mounted PIC16F18877 device.

Provides power to the downstream E-blocks boards via the port connectors.

Contains the Matrix Ghost chip which allows for real time in-circuit debugging when combined
with Flowcode.
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For Arduino programmer overview please refer to Appendix 1, SECTION A (page 89).

For E-blocks1 programmer overview please refer to Appendix 2, SECTION A (page 94).
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BL0114 Combo Board
The board combines together on one compact board the functionality found on a number of
individual E-blocks boards:

e BLO167 LED board (x2)
e BLO169 LCD board
e BL0145 Switch board (x2)
e For this course, the port connectors attach to female connectors on ports A and B of the
upstream board.

e The board provides a set of eight switches and eight LEDs for port A and the same for port B.

e With the main switch in the DIG position, port A is routed to its push switches (SAO to SA7), to
LEDs (LAO to LA7) and to the quad 7-segment display.

e \With the main switch in the ANA position, port A is switched to the analogue sensor section of
the board, so that pin RAO is connected to the on-board light sensor and pin RA1 is connected
to the potentiometer to give a variable output voltage, (simulating the action of an analogue
sensing subsystem).

Note: With the switch in the ANA position, the on-board switches and LEDs LAO and LA1
will not operate.

e Port B /O pins are routed to its push switches (SBO to SB7), to the LEDs (LBO to LB7), to the
guad 7-segment displays and to the LCD display.
e The quad 7-segment display is turned on by switch ‘7SEG’. It is connected to both port A and B.
e Port B is used to control the LED segments and the decimal point).
e Port A, bits 0 to 3, select which display is activated.

e The LCDis a 20 character x 4 lines module, turned on by switch ‘LCD’. Normally a complex
device to program, Flowcode takes care of the complexities, unseen by the user.

I .:ﬂmnéi-tﬁﬂmnca-aanca'g_ m G BLD114"

Ly -

For E-blocks1 combo board (EB083) overview please see Appendix 1, SECTION B (page 95).
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Connecting E-blocks together

E-blocks2 are built on a bus-based concept. Each E-block connects
together with a 16 pin Har-flex connector, with the female ports
attached to the ’intelligent’ upstream boards and the male

connectors attached to downstream boards.

The diagram shows that the first Upstream Connector - Female S1 g E0a
three pins are used to transfer the I HE LT i

BEBN0EAQE I L1
power to the downstream board, . 2 IR
. 3
ins 4,15 and 16 are reserved. sV
p ,15 and 16 are reserved LT £ SCK/MCLR
I FEMALE I = oo
; Data Pin 0 7 L
Pins 5 and 6 are connected to I I DataPin 5 [
ground while pins 7-14 are the e o pATA2
. . . - F DATA3
pins which transfer our 8 bits Downstream Connector - Male Data Pint_[ 11 ] paras
worth of data between the boards. EiEElLan Data Pin6 | 13 | parho
TEBEODEAD Data Pin 7 14| DATAS
LTS 15 | spa/PGD
. ) . . Reserved 16 [
or E-blocks1 connections please see
Appendix 2, SECTION C (page 96). II MALE II L

Using E-blocks on the bench

You do not need a backplane to use E-blocks - you can simply
connect them together on the bench.

In each E-blocks package you will find a four small rubber feet to
facilitate this. These provide a degree of protection for the E-

blocks boards and help prevent short-circuits from tinned copper
wire and other metal objects on the bench. | A

The disadvantage is that your E-blocks system is less portable as

the connectors will be under more stress as the system is moved
about.

Protecting E-blocks circuitry

Where possible, leaded components have been used for devices on E-blocks boards that are
susceptible to electrical damage. This makes the task of replacing them simple should they be
damaged.
To protect ‘upstream’ components, all ‘downstream’ E-blocks boards include protective resistors.
Should errors occur when declaring the nature of port pins, e.g. an input declared as an output, no
damage will be caused.
However there are circumstances where it is possible to cause damage:

e Care is needed when using screw terminal connectors and patch/prototype boards.

e Where possible, use protective resistors for the lines you need to connect when connecting

two ‘upstream’ boards together with a gender changer E-block.

e Make sure you are earthed before handling E-blocks circuit boards to minimise the risk of
static damage. If you have not got an antistatic wrist band, then touch a radiator or other
earthed metal object.

Before making any changes to the E-blocks system, turn off the power supply.
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Section 3: Introduction to
Flowcode

Flowcode allows you to create microcontroller applications by dragging and
dropping icons on to a flowchart to create programs. These can control external
devices attached to the microcontroller such as LEDs, LCD displays etc.

Once the flowchart has been designed, its behaviour can be simulated in Flowcode
before the flowchart is compiled, assembled and transferred to a microcontroller.
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Introduction to Flowcode

This section allows those who are new to Flowcode to understand how it can be used to develop
programs. It allows you to create programs step-by-step to learn about how Flowcode works.
We advise that you work through every section to familiarise you with all of the options and
features of Flowcode and introduce you to a range of programming techniques. As you work
through each Section, please also refer to the Flowcode help file. The main Flowcode icons are
introduced in turn.

Specifically in this section you will learn:

how to use each Flowcode icon (except the C code icon).
how the fundamental Components in Flowcode work - the LED, LCD, ADC, switch, 7-segment
display, 7-segment quad display, keypad and EEPROM components.

What is Flowcode

The process

l.
2.

Create a new flowchart, specifying the microcontroller that you wish to target.
Drag and drop icons from the toolbar onto the flowchart and configure them to create the
program.

. Add external devices by clicking on the buttons in the components toolbar.

Edit their properties, including how they are connected to the microcontroller, and configure
any macros they use.

Run the simulation to check that the program behaves as expected.

Transfer the program to the microcontroller by compiling the flowchart to C, then to assembler
code and finally to object code.

Flowcode overview
The Flowcode environment consists of:

a main work area in which the flowchart windows are displayed.

a number of toolbars that allow icons and components to be added to the flowchart.

the System and Dashboard panels that display the attached components and provide basic
drawing capabilities.

the Project Explorer panel that shows project variables, macros and component macros.
the Icon List panel that shows bookmarks, breakpoints and search results.

windows that allow the status of the microcontroller to be viewed.

windows that display variables and macro calls when the flowchart is being simulated.
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n to Flowcode

Dark Style

. New Project

Open Project

Open Template

Templates

Light Style

~
New Project

[=]

Open Template

- Open Project
: D Launch Help

8]

Flowcode - Start Page
FILE VIEW HELP

. v Toolbar

Status Bar

Style

Global Options...

Flowcode can be used in a dark or light style Goto > View > Style > Light / Dark

FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP
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A typical screen (testing the 7SEG)
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I The toolbars and panels
o Icons toolbar
Drag-and-drop icons from this toolbar onto the main flowchart window to create the
D flowchart application. Normally positioned on the LEFT hand side of the screen,
but it can be undocked.
0 ? O B » EIED 1 2
) Sesren e Faveurtes | inputs | v outpurs [ ) Dispiays p((( sensors ) comms T Wireless 55 storage N Mecnatronics [l MIAC Mosule BDsp 0 smutstion [T Toois A® snapes
QA t Components toolbar
Connect external components to the microcontroller or use basic panel drawing
commands. Components are grouped in different categories that appear as drop down
[ menus. Click on a component and it will be added to the microcontroller and appear on
7% the panel. The pin connections and properties of the component can then be edited.
f .' Normally positioned on the TOP left hand side of the screen next to the Icons toolbar
SIH this toolbar, it can be undocked.
& Menu and simulation toolbar
= e Open and save files.
e Undo and redo actions.
c e Print out your flowchart.
e Control the simulation and download functions.
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Dashboard & System Panels

The components that you connect to the microcontroller will be displayed on one of these panels where

you can interact with them when running a simulation.

They also provide basic drawing features
like lines, shapes, and images, which can
be used to build advanced professional-

looking panels. d -

The Dashboard Panel is primarily for 2D
use although it does offers a fixed 3D view. |-
It is generally used as an interface showing
the controls for interactive components.

B ps oo e po B o B P F o po e o pe o fE EO

The System Panel is the main 3D panel,
offering many more features and options:
e full camera control.

editable background environments with default Sky Dome and World Dome views.

[ ]
e the option to use an image as the background.
e Shadow mode, offering both Tabletop and Object shadow options.

More details on these panels are found in the 'Flowcode - Getting Started Guide’.

(View > 3D: System Panel) / (View > 2D: Dashboard Panel)

Properties panel

All items on the panel, including the panel itself, have associated properties
that are displayed in the Properties pane when the item is selected.

Some are read-only while others can be manipulated.

Some, like size and position, change as you interact with the item.

Others allow access to more advanced features of the selected item.

The Properties pane typically docks to the right hand side of the screen but
looks like this when undocked:

(View > Panel Properties)

Project explorer

The buttons along the top of this panel allow you to select Ports, Globals,

Macros and Components.

® Ports - variable names assigned to the microcontroller ports.

e Globals- any constants and variables that have been defined for use in the
current project.

e Macros - user-created macros in the current program and allows the user to
drag them into the current flowchart.

e Components - similar except that it also lists components that are present in
the panel.

(View > Project Explorer)

Icon list

All bookmarks, breakpoints and disabled icons are listed,
together with search and error results.

led_7seg_gquadl -

t

g B
-
¢ Hande led_7seg_qu...
‘o Type 7Segment (...
= Properties
- E Display... Anode M
-+ ShowSe... Yes -
—I-'# Connections

- Com... $PORTA.0

M Com... $PORTA.1
- Com... $PORTA.2
- Com... $PORTA.3
M Pn0  $PORTB.O
- Pinl $PORTB.1
M Pn2  $PORTB.2
M Pn3  $PORTB.3
M P4 $PORTB.4

M Pr5  $PORTB.S
M Pn6  $PORTB.6 -~

Name "Component"
Component led 7seg gquadl

Project explorer == » I X

= Globals
- Constants
- <Add new>
- false
: true
=~ Variables
“— <Add new>

_I Bookmarks _-f-- Breakpoints

" Disabled Find results k Error results

o] Bookmarks|
(View > Icon Lists)
Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com
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Chip window

The pinout for the currently selected microcontroller chip is displayed. | ¢ %
When the flowchart is being simulated, the state of each “m
microcontroller 1/O pin is shown as red or blue, for ‘high’ or ‘low’ ol e
outputs respectively. - B o
view > hi =f i

REZAN3S
voo

RO7ANT

=3 RD&ANI

El

=
RATIANT 20|l ROSANZ
RABIANG 7|l ROD4ANZ
RCOANIE 2| RoTANZI
RCUANTY 25 W RoeANZ
RC2AN1E 24|@ RosANZI
RCIANTS W RCAAND
RDAAN4 2| ROVANZ

RDUANZS

E]

RDZANZE

Docking and undocking the toolbars and panes
Toolbars and panes can be undocked from their default positions and either be left free floating,
or docked to the top, bottom or the sides of the Flowcode window.

To undock a docked toolbar, simply click and hold on the toolbar grab bars (the speckled area at
the top or side of the toolbar) and drag the toolbar to its new position.

To dock it again, double-click on the grab bar.

B s roeme - 8 X
FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP
- e .
— - 10| ;
ODmOR ?® B» =1=IETEEE
Search Favourites Inputs Cutputs Displays Sensors  ff,} Comms Wireless Storage Mechatronics [#88] MIAC Module Dsp
[ e o
Project explorer %
3D: System Panel x
] LS =
R[HE &1 0W U & t
4] Globals|
Properties = =1 Constants
Call ComponentMacro - — <Add new>
led_7seq_quad1:ShowDigiQ. N false
1 o Icon lists x e
o)
| | Bookmarks =+ Breakpoints | Disabled Fmd results /gy Error resuits CAEE
elay 7 Hande  panel — = +— <Add new>
Tme = Properties &) Bookn

10
led_7seq_quad1:ShowDigi(,
2

u) | |:|

T
led_7seg_quad1::ShowDigit2
3,
Q)

2D: Dashboard Panel x

Name "Component”

Elll;ltw’ [&] v

B ko [0

Call Gomponenthacro Component panel
led_7seg_quad1:ShowDigif3.

0

Registered to: Dev User Current zoom = 75%

For Help, press F1

Example showing floating toolbars
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Flowchart window

The icons that make up the flowchart are displayed in this main
space. The text will change depending on properties selected, -
component macros called etc, The display names can be changed

by the user to aid project organisation.

A red star alongside an icon indicates that the flowchart has not

been saved in its current form.

0
->PORTE

300 ms

Simulation

When simulating a program in Flowcode a red
rectangle around an icon indicates the icon to be

executed next.

Simulation debugger
When simulating a flowchart, the
current values of any variables used in
the program appear in this window.
These are updated after a command is

Simulation debugger

Simulation speed

Macro Calls
Main

Call Component Macro
led_eb005::Start()

Call ComponentMacro
led_eb005::PrintString ("testing”)

Calculation
count = count+ 1

Call ComponentMacro
led_eb005::Cursor{13,
1

Call Component Macro
led_eb005::PrintNumber(count)

500 ms

Calculation
count = count + 1

Simulation delay:

Skip

{Show integers as hex!

simulated (unless the simulation is
running at full speed - 'As fast as

Expression

count
feed

P Cxpression)

Value

7
0

possible').

If you press the pause button during simulation, you can click on a variable in this window to

change its value (allowing you to test the program under known conditions).

The window also shows the current macro being simulated under the Macro Calls section, useful

when one macro calls another during the simulation process.
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Please also see Section 4 Flowcode First Program Page 43

VIEW MACRO DEBUG BUILD WINDOW  HELP
- &y - - B 0] =
?® & » P &

Favourites Inputs Outputs Displays Sensars Comms Wireless === Storage Mechatronics @l MIAC Module W DSP 4o Simulation ] Tools Shapes

Starting a new flowchart
e Create a new flowchart by selecting File > New or click the New button on the Main toolbar.
e Select the microcontroller that you wish to target from the list presented.
e Flowcode then displays that microcontroller in the Chip view (View > Chip) and creates an
empty flowchart for you to start adding your icons to.

Opening an existing flowchart
There are a number of ways of opening an existing Flowcode flowchart:
e Select the Open option from the File menu (File > Open) or click the Open button on the Main
toolbar. This will allow you to browse for the file you want.

or

e Select the file from the list of most recently used files in the File menu.
or

e Double-click on a Flowcode (.fcfx) file in Windows Explorer to launch Flowcode and open the file.

Saving a Flowchart
To save a flowchart, select either the Save or Save As options from the File menu.
(File > Save / Save As).
Flowcharts must be saved before they can be compiled to C or transferred to a microcontroller.

Saving Flowchart Images
To save an image of the currently active flowchart, select Save current Flowchart from the Save
Image sub-menu in the File menu (File > Save Image > Save current Flowchart).
This function saves an image of the program to any file in the format chosen from the list:
e Bitmap (*.bmp)
* JPEG (*.jpg;*.jpeg)
o GIF (*.gif)
e PNG (*.png)

Note that the current zoom rate is used to determine the resolution of the image saved. If you need
high quality images for printing then increase the zoom rate.

From the Save Image menu, you also have the option to save the current image of either the
Dashboard Panel or the System Panel

(File > Save Image > Save Dashboard image/Save System image).

These images can be saved to any file format chosen from the list:
e Model (*.mesh)

Bitmap (*.bmp)

JPEG (*.jpg;*.jpeg)

GIF (*.gif)

PNG (*.png)Model (*.mesh)
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The View menu
This dictates which panels and toolbars appear on the workspace, a useful feature when trying to
simplify its appearance.
It also has a Zoom menu, which allows you to display more icons in the workspace window than
when using the default zoom setting. The current zoom setting is displayed on the Zoom sub-
menu, and on the right hand side of the status bar, at the bottom of the Flowcode window.
The size of each icon is dictated by the zoom level - for larger icons, zoom in - for smaller icons,
zoom out. Use the Print Preview function to optimise the appearance of your flowchart on the
paper.
The Zoom menu can also be accessed by right-clicking on the flowchart workspace.
Function key shortcuts:

Increase Zoom (F3) - increases zoom size by 5%

Decrease zoom (F2) - decreases zoom size by 5%

Default zoom (F4) - set zoom to 75%

Zoom to fit - Zooms to fit the whole flowchart into the current window

Zoom to fit width - Zooms to fit the width of the flowchart into the width of the window.

Global Options
The View menu also includes a Global Options area, offering a series of powerful tools to configure
the flowchart (Goto > View > Global Options) One open, select the appropriate Tab.

EILE  VIEW HELP

D I ~  Toolbar

+  Status Bar

...... tyle b

Global Options...

Flowchart Tab

This tab contains the settings for changing Options x
font Style and Size and featu res of the icons- Flowchart Scheme  Annotations Application Editor Locations Scopes

Font name: lcon graphics style:

MS Sans Serif - Def:ultp

Fort size: Source graphics style:

40 - Default

] Indent loop flowiines
[J Restore Defaults Preview Cancel
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Scheme Tab

This tab contains the settings for changing the
appearance of the flowchart, including icon colours
and graphics, background colours and patterns etc.

Annotation Tab

All the settings on this tab relate to manipulating
the annotations on the flowchart, including icon
text and descriptions as well as annotation and
tooltip styles.

It also the ability to add icon comments in C code.

Application Tab

These settings affect the look and ‘feel’ of the
overall program.

The skin pre-sets and tab options change the
general look of Flowcode. It also offers the ability
to print in colour and to change web access
settings.

The Override language option allows the user to
override the default Flowcode language settings
and to display Flowcode in a specified language.
To do this, select the language from those available
on the drop down list and restart Flowcode.

It will do so in the selected language, provided the
relevant language pack has been installed.

Editor Tab

Auto-edit new icons opens the Properties pane
when a new icon is added to the flowchart.

Use the Add icons comments to C code option to
include their associated comments when icons are
compiled to C code.

The Allow errors in flowcharts option allows you
to edit icon properties without triggering error
messages.

The Allow unconnected ports and pins option
allows you to change component connections to
unconnected without triggering an error message
(though these will still occur during simulation and
compilation).

Copyright © 2016-18 Matrix Technology Solutions Limited

Section 3

Options

Reset custom colors

D Restore Defaults

Preview

Flowchart  Scheme Annotations Application Editor Locations Scopes

Scheme
Save as..

Background

Color 1 Style:

= -
Color 2 Selection: Execution:
| -

lcon

Options

Flowchart Scheme Annotations | Application Editor Locations Scopes

7] Show description foricons
Show text inside icons
7] Show annotations
Limt description size for all icons
Limit annotation size for new icons
Annotation style:
Flowcode

Toottip style:
Annotation

[J Restore Defaults

Preview

Cancel

Options

Flowchart  Scheme Annotations  Application  Editor Locations Scopes

Overide language

Document appearance
Skin

] Use tabs
7] Use atemative tab style
Use colored tabs
Print in color
] Use dashboard as default panel
Disable the system panel
] Show properties in tabs
Show popup on simulation end
Show all componerts within categories

Web access
/| Enable
Default settings
Direct access
Praxy settings
Address 192.168.0.1
Fort 80
Name

Password
Graphics engine
OpenGL hardware
Enable As Fast As Possble Mode

www.matrixtsl.com

[J Restore Defaults Preview Cancel
Options
Flowchart Scheme Annotations Application | Editor Locations Scopes
Auto-edt new icons
Code generation
| Add icons comments to C code
Allow errors in flowcharts
Alow unconnected pors and pins
[d Restore Defaults Preview Cancel

ildralX

39


http://www.matrixtsl.com

Introduction to Flowcode Section 3

Locations Tab x
Thls a“ows you to Choose the target d|rect0ry that Flowchart Scheme Annotations Application Editor Locations Scopes

Send compiler output to..

Flowcode compiles to by default. It also allows you | | Feresin

/| Create a backup file a5

to specify directories that Flowcode should search | | ecans coracsi zesnsen
when looking for components and dictionaries. "

Clear compenent cache

Lool for dictionaries in..

scope Tab [J Restore Defaults Preview Cancel
The Data Scope allows the user to see the results
and values from raw data and from components options x
themselves. This data is displayed during lmcion Stheme Ametstion Apphcaten Edkor Lacations [scopes
simulation and allows the user to monitor signals Sa 1| [ gt [
selected on the various scope channels. - e | | et [Re T2 i o2 T2
It can read and display data from a number of - = S::km —
different ports simultaneously. Adjusting the - e e
timebase allows the user to view a small amount Fot Fin 7 E— oo Temeite | Tenplte 1

Analogue Pins [— Template Name Template 1

of data at increased accuracy or larger amounts of | | ceonree = —
data.

D Rsstors Defauits Prevvis Cancel

Getting Help with Flowcode
Flowcode has within it and online an extensive wiki which can be

accessed through the program itself or via an internet browser
and visiting this page: i i
o '? Help...
http://www.matrixtsl.com/wiki/ tput Maliushsils —
Start P Online Resources...
You can also access the Flowcode wiki from inside the program =
itself by going to the ‘Help’ section of the Main Toolbar and chedetorUpdates..
clicking the Help... menu option from there. This will open up a Repart a Bug..
new internal window within Flowcode which will load the front
page of the Flowcode wiki.
Additionally every single component within Flowcode has a
page on the wiki which explains all the macros within it, and
usually includes some examples as well. Y Lockatine ongin
e
To access the component help simply right-click your mouse on BeEmiD 15

Selection 3

any component in either the 2D or 3D panel and select Help.

Key mappings 3

Cut

From here you can see:
e Explanation of the component o

e Some examples of the component in use
Properties
e Macro references explaining what each macro plus the -

parameters and return values.

Copy
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Getting Help with Flowcode

Flowcode has within it and online an extensive wiki which can
be accessed through the program itself or via an internet

browser and visiting this page:

http://www.matrixtsl.com/wiki/

You can also access the Flowcode wiki from inside the program
itself by going to the ‘Help’ section of the Main Toolbar and

clicking the Help... menu option from there. This will open up a
new internal window within Flowcode which will load the front

page of the Flowcode wiki.

Section 3

Do

HELP

D r? Help...

BAotr wh ito

Ltputs

start P Online Resources...

T arov|

Check for Updates...

Report a Bug...

Additionally every single component within Flowcode has a page
on the wiki which explains all the macros within it, and usually

includes some examples as well.

To access the component help simply right-click your mouse on
any component in either the 2D or 3D panel and select Help.

From here you can see:
e Explanation of the component
e Some examples of the component in use

9 @ @ 0= ~

Look at the arigin
Previous view

Zoom to 100%
Selection 3

Key mappings »

Cut

Copy

Paste

o

e Macro references explaining what each macro plus the parameters and return values.
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Section 4: Flowcode
First Program

Adding digital outputs - Light the LED
Create a program that lights an LED attached to the microcontroller.

This program introduces the topic of how to control a digital output.

The tutorial provides a clear, step by step approach enabling you to create your first
program using Flowcode. It can be run in Flowcode’s simulation mode before
compiling to the board for testing and development.

LU

LT ATt

PIC Progranmer

e EELDCKSE

Note: This tutorial refers to the port settings (ports A and B) as used with PIC.
For Arduino users, please use ports C and D as appropriate.
(Port C on the Arduino ‘Maps’ to Port A of the Combo board).
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Open Project

[
New Project

Open Template

Launch Help

=
L]
=

Start a new project

Select 'New' Project’ in the box or Goto > File > New and choose a
target microcontroller from the list that appears.

For the E-Blocks2 BLOO11 or BLOO80 programmer, select 16F18877.
(E-blocks1 use 16F1937)

(Arduino use Arduino Uno R3 PDIP)

Project Options
Choose a Target Project description  General Options

Choose a target for this flowchart

» Family PIC16F >

- = W 16F18326
No chip PIC M 16F18344
M 16F18345

S 7 | ™ 16F18346
; @l | W 16F1847
FREE PICI6 | m 16F18854
- M 16F18855

7 || B | ™ 16F18856

ARM || PIC32 | ™ 16F18857
M 16F18875

-l W 16F18876

< :
AVR | Favourtes M 16F1933
M 16F1934

0

Configure . i
Setting up the project can be

done in a variety of ways. Here
- the 16F18877 chip has been
selected via the PIC image.

Cancel

Instead of selecting the
16F18877 chip, the boards can
be selected directly. Here the
BLO011 board has been selected
via the FREE image.

Here the Arduino board has been
selected via the FREE image.

Project Options

Choose a Target Project description  General Options  Configure

Choose atarget for this lowchart:

No c!ip

Family Free -

M Arduino Uno R3 SMD

B Arduino Uno SMD

M BLOOSS

I BLODBG

B MIAC (Arduino-Compatible) System
B MIAC (Arduino-Compatible)

W 16F18877

W 16F1937

I 16F84A

W 16F877A

Family Free

W AT91SAM7S128

W BLOOG1

W EBO31

W ECIOARM

M Arduino LilyPad 328
M Arduino Uno PDIP

n
M Arduino Uno R3 SMD
M Arduino Uno SMD

B BLOOSS

W BLOO8G

Favourtes

W 16F18877

B MIAC (Arduino-Compatible) System
B MIAC (Arduino-Compatible)

W 16F88

e BLOOL 1

= BLOOSO
B ECIO-28

Favourtes

TIP: This can be changed later if you get it wrong.
Goto > Build > Project Options > Choose a Target
and select a target microcontroller from the list that
appears as before.
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FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP

By ?® B » €I {9 &+
| Search i Favourites 5 | Inputs » Outputs [ Displays -::(( Sensors 1) Comms T Wireless == Storage S5 Mechatronics  [#%8| MIAC Module  we== Dsp 40F Simuation | Tools A: Shapes
t Add an LED Array (PCB) to the 3D system panel.
Outputs The LED array can be found under Outputs in the
—— = Component Toolbar.
LED Cube Goto > Component Toolbar > Outputs >
D-'_‘_”__?lutium Geneia LED Array (PCB) > Add to 3D system panel
= D:ZCZT)rutput
T pwm

- 1]5) Piezo Sounder
-7 Speech
& Outputs: LEDs
= (@ LED (Generic, RGB)
- @ LED (RGB, PCB)
- #¥ |ED APAL02C
= g*. LED Array Template
B o w
é}‘. LED Charlieplex
B LED Matrix (Pare
¥ LED Matrix {Seric
LED MuttiColour E

Add to 3D system panel
Add to 2D dashboard panel

Details

Help

Add to favourites

Create a Flowchart.

Move the cursor over the Loop icon, in the Icon
toolbar. Click and drag it over to the work area.
While dragging it, the normal cursor changes into
a small icon. Move it in between the 'BEGIN' and
'END' icons. As you do so, an arrow appears
showing you where the Loop icon will be placed.
Release the mouse button to drop the icon in be-
tween the 'BEGIN' and 'END' boxes.

Output h /o

Loop H

N
S

s

INT

0

Add an Output icon
between the loop on
your flowchart in

* Cutput
the same way.
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Changing port setﬁngs Properties: Output b4
Double .CIICk on the S |§| Select Port B.
Output icon that you’ve Ouipu M Input a value of 1
put in your flowchart and Port '
PORTB -
the Properties box will
Variable or value: '* Dutp Ut
come up. 1 M ]
Qutputto: o PDHTB
Single Bit ::}
e Pert (You have done this be-
-+ Output L ing cause the LEDs in your 3D
0 5 4 3 2 1 0 system panel are currently
-» PORTA attached to port B, so we
= Cancel are sending the Output to
L the same port).

Run the simulation.
Select the Run icon from the menu bar and the simulation of
the LED will light up in the 3D system panel.

Run (F5)
FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP ‘
= L = s
F = - 10| :
Om ? & B » 10D fd £+
: Search *Favourites » | Inputs » Outputs .| Displays  p{({ Sensars E Comms "= Wireless == Storage ‘-n' Mechatronics  "®8 MIAC Module '"EDSP {}S\mulanon VT Tools 4 Shapes

Simulation mode

Stop (Shift+F5)

FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP ‘
B =) L =l H E
i = = 0] :
Dm ?® B » umIETE R
: Search i Favourites & | Inputs »Outputs [ Displays  p({( Sensors .} Comms  Z= Wireless == Storage  §0F Mechatronics |98 MIAC Module = Dsp  40F Smuiation | Tools A Shapes

TIP: Remember to stop your simulation before doing anything else.
(If Flowcode isn’t doing as you expect, check that you haven’t accidentally left your simulation running).
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Save your program and then Compile to chip to test on the board. You should see the first LED light up.
Select the Compile to chip image from the menu as shown, or Goto > Build > Compile to chip

Save (Control+S)

FILE EDIT V\JMACRO DEBUG BUILD WINDOW  HELP

NEoR PHEEE PN mOD EH

11 . — = -
\Search *Favuumes * | Inputs » Qutputs i Displays -]\‘\( Sensors I: Comms = Wireless === Storage E‘Mechatmmcs "‘“@ MIAC Module -:DSP QS\mu\ahun TTTUU\S ‘: Shapes

Compile to chip

FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP ‘
i = A 1
- [ g0l =88
D ?® 5> EIE B+
i \Search *Favoumes * | Inputs » Qutputs g Displays -1\‘\( Sensors I Comms = Wireless === Storage :*Mechatmm:s "“_'7‘{3 MIAC Module -EDSP QS\mu\auon TTToo\s ‘: Shapes

Lower row LEDs

Changes to try after successfully lighting your LED.

Highlight the image of the LED array in the 3D system panel and right click to select the Properties.
Here you can change the number of LEDs in your array by changing the value under count.

Try changing the colour of the LEDs in the simulation as shown below.

Standard Custom 0K
led_array_pcb1 - — R
. Properties FTLI-IPosition Macros
”_; / Select..
2" Handle led_array_pcb1
o Type LED Array (PCB) New
I= Properties
% count 6
E=-# Connections
. =Zpot  PORT v Current
M Port... $PORTBO
¥ polarty Active High v
= Simulation
- E glign X Axis -
spac... 12.000000
-+ reve... No i
-2 |abel... Above -
* color... [lloooorF

' label... [ |FFFFFF

Property settings for 6 red LEDS. 6 red LEDS in simulation.
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Changing the port settings.

Bring up the Output icon properties (double click) and change the Port settings to Port A.

Highlight the image of the LED array in the 3D system panel and right click to select the Properties, and
change the Port settings to Port A.

* {:lutp u‘t Properties X
1 |\ed_array_pcb1 -
Properties -_iJ-‘ Position Macros
e
= PORTA —

=

Handle led_array_pcb1

Type LED Array (PCB)
IZ Properties
A count 8 . . .
Properties: Qutput X E # Connections Run |n SImUlatlon mode
lil = port PORT hd
Display name: : H
and then compile to
[Outpui - £ polarty ROETA hd p
= Simulation e .
o i - . chip. You should see the
PORTA - i 9 rEwMCIR 1% a0 remis
I8 spac... | raomu W[ Resanis .
Variable or value: + reve... RAVANT L3 O ResaN - ﬁrst LED Of the Other
|1 - i label RAZIANZ WO ReUANIZ -
— RAVANI W[ REVANT .
o OO wide sy e - row light up.
o Name "CE  RASANS [ RELANI
Single Bit: Component le¢ REMANR 3 REVANS
RENANE Do
REzmis 10 s ves
Start Page = Prop DO W[ RoTANS
g i o e | Upper row LEDs
Entire Port RATMNT ] 13 28 ROSAN2S
RAGMNGE ] 14 T[] ROYANZS
Reamie (15 B[ Renmz
coEliEs Ty ctANT [ 18 5[0 reswiz
7 6 5 4 3 2 1 0 RC2AN1E O IT 247 RCHANZT
RCYANTS [ 18 23] RC4ANZD
Roomze [ 18 2 o
ROTANZS 21 [0 ROZANDS
Properties: Output x
Display name: Iil
Output hd
Port
PORTB A

or value:

Single Bit 2585

-> PORTE
Entire Port:
Use Masking:

7 6 5 4 3 2 1 0

You can practise changing the ports by changing them back to port B.
Change the value from 1 to 255. Test in simulation mode and then compile to chip (all 8 LEDs light up).

Experiment using other values. (TIP: See Number Systems Worksheet).
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Binary Numbers

Digital electronic devices can't cope with decimal numbers. Instead,

Decimal Same in binary
they use the binary system, which uses only two numbers 0 and 1. 0 5
The number 1 could be represented by a high voltage signal, while
number O could be a low voltage. 1 1
2 10
The decimal system uses ten numbers, 0,1, 2,3,4,5, 6,7, 8 and 9. 3 1
On reaching the last of these, 9, we start again with 0, but add
another number in front. For example, after 8 and 9 comes 10, and 4 100
after 18 and 19 comes 20 and so on. When we reach 99, both of 5 101
these go back to Os but with a 1 in front, to make 100. 6 110
7 111
BINARY VALUE » 1000
16 8 4 2 1 > 1001
10 1010
In binary, the same thing happens, but a lot more often, because it
uses only Os and 1s. Counting up starts with 0, then 1, then back to 0 Decimal Same in binary
with a 1 in front, making 10 (not ten - it's two) Next comes 11 (three) 1 1
and start again with two Os but with a 1 in front, to give 100 (four) 5 10
and so on.
4 100
Notice that each time the binary 1 moves one place to the left, it 8 1000

doubles in value of the number in decimal.
We can use this idea to convert between number systems.

TIP: In any binary number, the bit at the left-hand end, the Most Significant Bit (MSB), has the highest
value. The one at the right-hand end, the Least Significant Bit (LSB), is worth least.

Hex Numbers

Hexadecimal, 'hex' for short, is a another system for representing numbers.
e A binary digit is either O or 1.

e Adecimal digit varies between 0 and 10.

e A hex digit has sixteen possible states.

Sixteen states is a problem, as we have only the digits from 0 to 9. To get round this, we use the
letters A to F to provide the additional six digits required.

Working with the binary number with eight digits is a handy convention as computers (and the PIC
MCU) store information in groups of eight bits.

A single memory cell inside the PIC MCU can store a number ranging from 0000 0000 and
1111 1111. In decimal this range is 0 to 255. The equivalent in hex is 0 to FF.

TIP: You can enter a hex number into Flowcode by preceding it with 'Ox’ in any of the dialogue boxes.
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Flowcode First Program Number Systems

Coding Constructs - Number Systems
Binary value Decimal Binary Hex
Decimal value
16| 8 a4 2 1 0 00000000 0
1 1 1 00000001 1
1 0 2 2 00000010 2
1 0 0 4 3 00000011 3
1 0 0 0 8 4 00000100 4
S0 5 00000101 5
1 1 1 7 6 00000110 6
i L ! ° 7 00000111 7
1] o 1 0 0 20
8 00001000 8
1] 1 1 1 1 31
9 00001001 9
' o _ 10 00001010 A
A single memory cell inside a PIC device can
11 00001011 B
store a number ranging from 0000 0000 and i 00001100 c
1111 1111. In decimal this range is 0 to 255. 13 00001101 D
The equivalent in hex is 0 to FF. 14 00001110 E
15 00001111 F

Complete the table below by:
a) Shading in the LEDs that light, for the first three rows.
b) Working out what number produces the LED patterns shown in the last three rows.

Number sent to output LED array

7 B6 BS B4 B3 B2

51 00000000

204 5566560

B7 BE B5 B4 B3 B2 Bl

195 00000000
- 00000000
- 00000000

B7 B6 BS B4 B3I B2 B1 BO

00000000

D Use Flowcode to:

a) Check your work from the table above using Flowcode.
b) Enter a hex number into Flowcode by preceding it with '0x' in any of the dialogue boxes.
Can you light the same LED patterns using Hex?
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Section 5: Flowcode
Examples

All of these examples can be tried out using either a PIC or an Arduino
microcontroller.

Arduino users should familiarise themselves with Arduino Adjustments in
Appendix 1, (page 88) and adjust any port settings accordingly.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX

50


http://www.matrixtsl.com

Flowcode Example 1 Fire

Example 1. Adding digital inputs - Where's the fire?

LApUis

The scenario

Heat
Sensor 1 .
A large building has a number of heat sensors in its
fire alarm system. When there is a fire, the fire 5:::: .
brigade needs to know where the fire is. In other —

words, they need to know which heat sensor has -
triggered the alarm. A=
The system is controlled by a PIC MCU. There are five
heat sensors, connected as inputs to port A. Port B is -

set up as the output port and connected to a set of ’

five LEDs. If a heat sensor detects a fire, the -
corresponding LED lights up.

The PIC fire monitor

Setting up the flowchart

Open Flowcode and create a new project
suitable for the board you are using.

Drag the Loop icon, the Imput icon and
the Output icon into your Flowchart from
the icon toolbar to create a Flowchart as
shown.

Set Imput to port A and Output to port B.

For Arduino users, please use ports C and
D as appropriate.

*
PORTA -=
(Port C on the Arduino ‘Maps’ to Port A of 0

the Combo board). | _ |
*Output .
7 % - -» PORTA
SIM
INT
C
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Flowcode Example 1

Creating the variables

e Right-click on the input icon, and select Properties from S -
the menu. The Input Properties dialogue box appears, — @
shown opposite. This allows us to add a variable. = -

But what is a variable? —— =
A variable is a place where we can store information, in Verchie
particular, information that changes as our program runs. | 5= .
In this case, it is the number of the heat sensor that fputfiom
. . Single Bit
triggers the alarm. It might be sensor 1 that goes off, or
sensor 5.... . 15 =
Entire Port: = Globals
We are going to use a variable called SENSOR to store . i o
. . . . se Masking:
the information on which sensor has been triggered. s s s 4 5 ol i ~bfake
true
"+ Variables
. . - <Add new>
e Click on the arrow next to the Variable box. =l | )3 SENSOR
. . ~I-+ Properties
You will see the next dialogue box. 7. led_array_pcbl::port

e Now hover over the word Variables and the arrow Create = New Variable «

appears. Click on it and select Add new. Moy e

Another dialogue box, shown opposite, appears, [
offering a large choice of variable types. For now, i”“‘a'"a‘“e
accept the default type of Byte, a variable which

Description:
can store numbers from 0 to 255.
Type the name SENSOR as the name of the new Variable type:
. . Bool (either true, 1 or false, ()
variable and click on the ‘OK’ button. It now appears et
X . . Byte (number in the range 0 to 255)
in the list of variables that the flowchart can use. Int (number in the range -32768 to 32767)

Ulnt (number in the range 0 to 65535)
Long (number in the range -2147483648 to 2147483647)
ULong (number in the range 0 to 4294967295)

e Double-click on the name of the variable to use it, .
. i K String (default size = 20)
or alternatively click and drag the name into the Flosting point
variable box. Objecthandle

0

You now see the Input Properties box again.
Notice that you need to tell the system which port
you are going to use to input the data the system needs. It is set to port A at the moment, and
we are going to leave it that way.

In this case, the system needs to monitor the heat sensors and so each sensor will be connected
to a different bit of port A. Click on ‘OK’ to close the Input Properties box.
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Flowcode Example 1 Fire

More on variables

[reate a New Variable X

In the previous section you added a variable to the program R
using the variable dialogue box. [

Initial value:

Computer signals consist of streams of binary Os and 1s on |
each wire. A group of eight wires can carry eight bits, (binary | oescipton
digits) simultaneously. This grouping of eight bits, known as a

Variable type:

byte is used for much of the internal wiring inside Bool (either ue, 1 oralsa, )
microcontrollers and for the registers that hold and process Byte (number in the range 0o 255)
Int (number in the range -32768 to 32767)

d ata * Ulnt (number in the range 0 to 65535)
It is also used within memory subsystems. The contents of a Long (numberin he range 2147483543 1o 2147:63647)

. . . . ULong (number in the range 0 to 4294967295)
memory register having eight bits can vary from 0 to 255. Sting (defaul size = 20)
A variable inside Flowcode can be configured to use just one PRI

Object handle

memory register or more than one.

O

Flowcode variables:

Flowcode offers eight different types of variables:

e aBool (Boolean) variable can either be 1 or O (true or false).

e asingle register, known as a Byte variable, can store numbers from 0 to 255.

e adouble register, known as an Int variable, can store numbers from -32768 to +32767.

e adouble register can also be unsigned, when it is known as a Ulnt variable, which can store
numbers from 0 to 65535.

e aquad register, known as a Long variable, can store numbers from -2147483648 to
2147483647.

e aquad register can also be unsigned, when it is known as a ULong variable, which can store
numbers from 0 to 4294967295.

TIP: Use a Byte variable for simple counters and for variables that will not go above the value 255.
It is the most economical in terms of memory space and also the fastest. Mathematical processes
involving two bytes (often referred to as 16 bit arithmetic) take longer to execute. A multiple
register, known as a String variable, can consist of a number of Byte variables - the default in
Flowcode is 20.

Other variable issues
Floating point numbers (that contain a decimal point somewhere in them), can also be used,
although they represent a much wider range of values than an integer. They suffer a loss of
accuracy over large ranges.
Finally an object handle is used to reference a more complicated piece of data (such as a file,
component or a block of text) whose internal format is not known.

Why worry?
The number of registers inside a microcontroller is limited, and in larger applications the number
and types of variables must be managed carefully to ensure that there are enough.
On downloading a program, the variables in Flowcode are implemented in the Random Access
Memory (RAM) Section of the PIC MCU. In the 16F18877 there are 4096 Bytes of memory. This
means you can have 4096 Byte variables, 2048 Int variables or 204 Strings each consisting of
twenty Bytes or characters.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX


http://www.matrixtsl.com
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Setting up the outputs

e Next, right-click on the Output icon, and select Properties or just | =
double-click on it. The Output Properties box appears. =N

e C(Click on the arrow, next to the Variable box. You will see the !
SENSOR variable listed. Input

e Double-click on the word SENSOR or click and drag it to the - S
Variable box.

e The Output Properties box now shows that the system is set to ﬁ SENSOR
output whatever data is stored in the SENSOR variable. Change i
the port used to port B, by clicking on the arrow, in the port
window, and then clicking on PORTB in the menu that opens.

e Click on ‘OK’ to close the Output Properties box.

e The flowchart should now look like this:

Notice the arrows in the icon annotations. They show that information will flow from port A
into the flowchart, via SENSOR, (Input icon) and from the flowchart, via SENSOR, out to port B
(Output icon).

FILE EDIT VIEW MACRO DEBUG BUILD WINDOW HELP

= = s =L i)
) T O g » B B @
4 Search * F.\\-ourileg‘ * | Inputs » Outputs . Displays b Sensors ‘ Comms . Wireless E Storage ; Mechatronics =il p1A

N NS

Adding the LEDs

e Now click on the Outputs button and select the LED Array (PCB)
icon. Click-and-drag it onto the System Panel.

e Change the Count property under the Simulation section to the
value 5 by clicking on the box next to the Count property and
using the keyboard to input the value.

e Click next to Port under the Connections section to open an
interactive view of the chip, showing the compatible pins.

e C(lick on the drop-down menu and select the PORT B option. You have now connected the LEDs
to the pins on port B.

(For Arduino users, please use ports C and D as appropriate).
Adding the switches

e You are going to use five switches to simulate the five heat sensors. The switch that is
‘on’ (closed) is the heat sensor that has triggered the fire alarm.

e Click on the Inputs button and select the Switch Array (slide). Drag it into a suitable spot on the
System Panel.

e Click on the box next to the Count property and change the value to 5. Check that the
component is connected to PORTA.

Simulating the program
e Click once on the Step Into button. The Simulation Debugger window appears but ignore it for
now.
e Move the cursor over one of the switches and click, to simulate detecting a fire. The switch
graphic toggles to the closed position. Click the Step Into button a few more times to simulate
the complete program.

The program is finished. You have just detected a fire, which turned on a heat sensor.
The LED array tells you, or the fire brigade, which sensor detected the fire.
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Example 2. Using loops - Counting sheep

Setting up the flowchart *|Loop

(For Arduino users, please use ports C and D as appropriate).

Creating the variables

Counting sheep, badly at first, but without falling asleep!

The plan is straightforward - when a sheep passes through the gate, it
breaks a light beam. This sends a pulse to a counting system, which then
adds one to the total stored in the system.

We display this total on the LED array.

(Note that Flowcode has a Beam Breaker component, based on the Collision Detector. Although
this would do a far better job, for now we detect the light
beam interruption using more basic methods).

Launch Flowcode and start a new flowchart. ‘ia'fh"e

Create the flowchart shown opposite.
It contains a Loop icon and a Calculation icon. *linput I
It contains an Imput icon and an Output icon. o

*|Calculation
.=;>-

*|Output

0
- PORTA

We are going to create two variables, one called SHEEP and the other
called TOTAL. R 3=
e The SHEEP variable will show whether a sheep is present or not. :

e The variable TOTAL will store the total number of sheep recorded so |/0 E"ants
far.

D) - <Add new>
e Click View on the menu bar, and ensure that Project Explorer is - b fakse
checked (View > Project Explorer). BVa;;ﬁes
e Click on the Globals button at the top of the Project Explorer panel. : - <Add new>
e Hover over Variable in the project explorer panel and click on the o i"{'}ETE:L

arrow to Add new. You now see the Create a New Variable dialogue
box. Type in the name SHEEP and then click on ‘OK’. You can leave
the variable type as Byte as there will not be that many sheep.

e Create a variable named TOTAL in the same way.
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Flowcode Example 2 Sheep

. . i ' Properties: Calculation L&J
Setting up the calculation —
i ion i Casaon & (gl oo fx £$
e Double-click on the Calculation icon to open T Globals
. . alcuilations: E—7- Constants
the Properties dialogue box. = b
e Change the Display name to "New total". R e

B ToTAL

e Create the calculation by typing the following
in the Calculations window: — ;
TOTAL = TOTAL + SHEEP B (Carcs |

e We will simulate breaking the light beam
using a switch on port A bit 0.

e The Input properties are set up to store whatever number appears on port A in the variable
called SHEEP. Initially, that number is 0. When the switch is pressed, the number on port A and
stored in the variable SHEEP is 1 (with only one switch, the biggest number we can create on
port Ais 1).

When the Calculation icon is executed, the number stored in the variable SHEEP is added to
the TOTAL variable. Hence, when a sheep breaks the light beam, TOTAL is increased by 1. With
no sheep present, TOTAL remains unchanged.

e Click on the ‘OK’ button, to close the dialogue box.

Configuring loop properties

r

e Double-click on the Loop icon to open its =1 i
Properties dialogue box. (This shows the Display name:
options for controlling the loop). = ]
Next to the Loop while statement is the loop || * z;w:t'l 1 -l
control text box, where you write the loop ' Testtheloen 2 e
condition (the program continues looping End
until this condition is met). Loop court: 1
Examples of loop conditions: B oK ] [ canca
e count=10 (Loop runsaslongas & d
the variable 'count' = 10)
e count>4 (Loop runs as long as the 'count' is greater than 4)

e count = preset (Loop runs as long as the 'count’ is the same as the variable ‘preset’)

In all of these, looping continues as long as the condition in the Loop while text box is 'true’.

In programming 'true' has a special meaning. It is assigned a numerical value of 1 so that a test
can determine if something is ‘true’. Similarly 'false' is assigned the numerical value 0.

The default condition in the Loop while text box is 1 - this condition is always 'true' and so with
this value, the loop will run forever. Programs usually contain a ‘loop forever’ structure. If they
do not, the program will end suddenly and the computer will just sit there doing nothing.

When to test?
You can configure the properties to test the loop condition either at the start of the loop or at the
end. Understanding this option is important. It can affect the number of times that the program
will loop.

Loop for a set number of times
Sometimes, you just want to run a loop for a set number of iterations. To do this, check the Loop
count box and enter the number of loops you want in the associated text box.
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Flowcode Example 2 Sheep

Setting up the input e =

e Right-click on the Input icon, and select Properties from | =" ]
the menu, to see the following dialogue box: e e .

e Change the display name. Double-click on Input in the o
Display name box and type "Check the sensor". oot sewre

e Click on the arrow next to the Variable box to open the : S
Variable Manager. B CEFFEE r;

e Double-click on the word 'SHEEP' to insert it into the () ==
Variable box.

e By default, the input is port A, which is what we want, (Arduino use PORTC), Click on ‘OK’ to
close the dialogue box.

Setting up the output

Double-click on the Output icon to open the output Properties dialogue box.

Click on the arrow next to the Variable box.

Double-click on the word TOTAL to insert it into the Variable box.

In the output Properties box, change the port used to PORTB, (Arduino use PORTD).
Click on 'OK' to close the dialogue box.

The flowchart should now look like this:

Loop

check the sensor

PORTA ->
SHEEP

MNew total
TOTAL = TOTAL + SHEEP

Cutput
TOTAL
-> PORTE

(For Arduino users, please use ports C and D as appropriate).

Adding the LED array
e Click once on the Outputs box and select the LED Array icon. Place it on the System Panel by
moving the cursor over it and then ‘clicking-and-dragging’ it into position.
e Change the value of the Count property to 8 to set the number of LEDs in the array.
e Click the Connections property in the Properties pane. Select PORTB from the drop-down
menu to connect the LEDs to the pins on port B.
e You can change the colour of the LED array in the Colors section.
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Flowcode Example 2

Adding the switch

e Asingle push switch will represent the light beam sensor.

e Click once on the Input box and select Switch (Push,Panel) icon. Add or drag it onto the
System Panel.

e On the Properties pane Connections section, check that the Connection property for the
switch is SPORTA.O i.e. the switch is connected to port A bit 0.

e Goto > Shapes > Label in the System Panel toolbar to create text.

e Click on the Label property in the Properties pane and replace the default text with "Light
beam interruption".

e To adjust the size of the text, click on the Position tab and change the values of ‘Width’ and
‘Height’ under the ‘World size’ section. Move the text to a suitable position next to the switch.

shape_labell - shape_labell -

4.8

= B
¢+ Handle shape_labell - Handle shape_labelt
s Type Label — Type Label
= Properties Iz Appearance
L@ Color M 1E25BF & Visble Yes -
L% Backgr.. [ Clear & Interactive ~ Yes -
i~ f Font Arial - - Solid Yes -
=5 Text Light beam interruption =+ Position locks
~& Lock a... No M
& Llockc... No M
& Lock size No -
& Llockr... No -
=7 Posttion
=7 World coordinates
R X -30.00000
Y 70.00000
z 0.00000
- World size
4 Width  70.93333 mm
Height 8.00000 mm
<[4 Depth 0.00000 mm

=" Rotation

X 0.00000
Y 0.00000
z 0.00000

Name "Component” Name "Component”
Component shape_labsll Component shaps_labell

Simulating the program
e Now run the simulation by clicking on the Run button.
e The Simulation debugger window appears - close it as it is not needed.
e Move the cursor over the switch and give the briefest mouse click you can.

What happens depends on how quickly you click, and how fast the PC works.

We want only the BO LED to light, to show a total of 1 sheep. The program runs at high speed,
however, and so keeps cycling through the Input and Calculation steps. As a result, before you
have time to release the push switch, the total has incremented (increased by one) several times.
This problem is explored in the next section.
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The solution: Adding a Delay

The problem - the program runs too fast!

Before we have time to release the switch, the program has run through several times, adding one
to the total each time.

We need to slow it down by adding a delay.
e Move the cursor over the Delay icon.
e Drag it onto the main work area and drop it between the Calculation and the Output icons.

=

Loop

While
1

check the sensor

PORTA -=
SHEEP

New total
TOTAL = TOTAL + SHEEP

Delay
r
- 200 ms Properties: Delay @
Display name:
Cutput [elay] -
TOTAL Delay value or variable
-> PORTE B =l
_) microseconds @ miliseconds _) seconds

e Double-click on the Delay icon to
open the Properties dialogue box.

e Change the value in the Delay value or variable box to 200 and then click on the ‘OK’ button.
This causes a 200 millisecond (0.2 second) delay when the Delay icon is activated. In other
words, the system just sits there and does nothing for 0.2 seconds.

e Now run the simulation again. Providing you don't keep it pressed for too long, you should find
that the LED array shows an increase of 1 each time you press the switch.

e The program now works satisfactorily, providing the sheep rush through the light beam in less
than 0.2 seconds. The delay could be increased to allow for slower sheep!

Note: This program shows the total number of sheep in binary format.
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Flowcode Example 3 Messages

Example 3. The LCD display - Posting messages

Programs using the LCD display need to use the crystal
oscillator. If necessary, in Flowcode, select Build from the
main menu, then Project Options and finally the Configure
tab. Select the crystal oscillator from the list of options
(Build > Project Options >Configure).

LCD displays
Flowcode comes with a number of components that add commonly used subsystems to Flowcode,
such as the LCD display, 7-segment display, and analogue inputs devices.

Here, we look at the LCD display, the basic text display subsystem on a range of electronics
devices, from calculators to mobile phones. It can display text or numbers on one or more rows of
the display.

In most programming languages, the LCD is one of the last things you learn, as it is quite a
complicated device to program. However, Flowcode takes care of the complexities, making the
LCD simple to use. The LCD display referred to here is the one used on the E-Blocks Combo board
and on the LCD display - a four row, twenty character display.

Adding the LCD component
Before you can use the LCD, you need to add a LCD component to a Flowcode panel.

To do so, click on the Displays box, select the LCD (Generic, 20x4) component from the menu and
add it to the System Panel. A LCD display mimic will now appear on the panel.

At the top of the Properties pane, the Component section identifies the component you have just
selected. By default, the LCD is added to port B.

The LCD display requires five connections. It displays letters and numbers conveyed as serial data
on this five wire bus. The techniques involved go beyond this tutorial. Fortunately, Flowcode has
some embedded routines that take care of the complexities.

Drag a Component Macro icon onto the flowchart and open up the corresponding macro dialogue
box by double-clicking on it.

B
-
E

S

Properties: Macro
Display name:
Now scroll through the LCD section in Components and Cal Conporert Mecro =]
e e ene [y Components -
select the macro called Start. This initiates the LCD, clears E!E%;ép;l i
..... ear
the display and gets it ready for action. We examine more i Geatne,
LCD macros in the next couple of sections, but for now scroll "0 prmea
. T 1 . [T PrintMumber -
through the available macros and take a quick look at each. ~00 g
Name ITyne [Expression
[ =
OkaEdtMace | [ ok | [ cancel |
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Writing messages e ——— N

Display name

[Call Component Macro! -

Macros Components Simulation fy, Functions

To display text on the LCD, simply type it in.

e Add another Component Macro to the flowchart and e 2
open the macro dialogue box. .jiléi_gnmffd

e Select the LCD macro called PrintString. This requires a Ei Etgmmbmmb
single parameter (item of data), 'Text' (the text to be e <
printed). L v

e Type the text into the parameter box surrounded by
guotation marks, e.g. "Hello World"

@ OK & EditMacro Cancel

e Runthe program and the text will be sent to the LCD display.

Call Component Macro
led_eb005::Start()

¥ [Call ComponentMacro
led_eb005::PrintString("Hello World?)

Other LCD functions
There are a number of other useful functions in the LCD macro list:

Clear - Clears the display and resets the cursor position (where the display prints next,) to '0,0' i.e.
top left.

Cursor - Moves the cursor to the specified location. The two parameters, ‘X’ and ‘Y’ select the
horizontal and vertical positions of the cell respectively. ‘0,0’ is the top left cell, ‘0,1’ the first cell
on the second line, ‘3,2’ the fourth cell on the third line etc.

PrintNumber - Works like 'PrintString' but prints a number instead of a string. It can be used with
variables, or with actual numbers.
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Using PrintNumber
Altogether we will add four Component Macros to the flowchart.

e To the first Component Macro add Start.
e To the second select PrintString and add "Hello World" (with quotation marks).

To the third select Cursor and add 0,1 to the parameters.
To the fourth select PrintNumber with the parameter value as 123.
Click Run to simulate the program.

¥*|Call ComponentMacm
led_4x20::Start)

¥|Call Component Macm
led_4x20::PrintString("Hello World?)

¥*|Call ComponentMacmo
led_4x20:Cursor(D.
1)

Call ComponentMacro
led_4x20::PrintNumber(123)

TIP: Try changing the values of the Cursor parameters and see where the numbers print.
The ‘y’ value needs to be between 0 and 3 and the ‘X’ value needs to be between 0 and 19.
(between 3 and 17 to see all three figures 1 and 2 and 3).

Parameters:

Mame Type Expression
X BYTE 17 -
Y BYTE 3 -
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Flowcode Example 4 Stopwatch

Example 4. Stopwatch
This example uses example 5 (Using PrintNumber) as a starting point.

e Expand the program from the previous example (Using PrintNumber) by dragging a Loop icon
below the PrintString Component Macro.

e Change the text in the PrintString Component Macro to "Hundredths" (with quotation marks).

e Drag a Calculation icon into the Loop.

e Create a variable called Count as an Int type (Initial value 0).

e Double-click on the Calculation icon. In the Calculations text box type Count = Count + 1
(This will add 1 to the value of variable count every time the icon is executed).

e Next drag another Component Macro into the Loop.

Double-click the Component Macro and find Cursor under the LCD macros.

Enter 0,1 as parameters to position the cursor on the first character of the second line.
Next, drag another Component Macro onto the workspace.

Select PrintNumber and enter Count as the parameter.

e Now, drag a Delay icon into the flowchart and set the delay to 10ms (which equals one
hundredth of a second).

e The counter will count (approximately) the time elapsed in hundredths of seconds.

Call Component Macro
led_4x20::Start{)

CEI”CDn'IpDI‘IBntMEICFD UUUEUUUUUUUUUEUB

led_4=20::PrintString("Hundredths")

10 ms

Calculation
Count=count+ 1

Call Component Macro

led._dx20-Cursor(, TIP: You can refine the program by clicking
R on each icon and entering comments to
describe what the icon does.

Call Component Macro
led_4x20::PrintNumber(Count)

It may seem like a lot of effort, but it
can help with more complex programs.
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Flowcode Example 5 Calculator

Example 5. Using binary numbers - A binary calculator.

Switches

In this section you build a binary adder - a
system that makes the microcontroller add
two numbers.

The simplest way to input a binary number is
to use a set of switches attached to the input

"
LED Arra
port. Input 1= 1000110 ™20 :
~=f4Part B
To input two numbers, we need two sets of 330000002
switches and two input ports. Switches

To see the result of the calculation, we will use
an LED array, connected to the output port.

We need a microcontroller with three ports. PIC - the adderl

Ihput 2 = 0111000

Setting up the flowchart

e Launch Flowcode and start a new flowchart.

e This time we take notice of this dialogue box: - Looe
We need a microcontroller with at least three ports. i
Pull the slide bar down to find the 16F18877PIC MCU.

e Click on it to select it and then click on ‘OK’. o nuber

e Click-and-drag a Loop icon. e

e C(lick-and-drag an Input icon and drop it between the Inputthe second number
ends of the loop. FiE

e C(lick and drag a second Input icon and drop it in
between the ends of the loop. g o

e C(lick and drag an Output icon and drop it just below the
Input boxes. e

e Click and drag a Calculation icon, and place it in SFUAIE
between the second Input icon and the Output icon.

e Your flowchart will look similar to this:

(the example image has descriptions and variables added).
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Flowcode Example 5

Creating the variables

Click View on the menu bar and ensure that Project Explorer is
checked (View > Project Explorer).

Click on the Globals button at the top of the Project Explorer panel.

Calculator

We are going to create three variables, called inputl, input2 and sum. | P

The first two store the numbers fed in from the switches. The variable

sum stores the result of adding them together.

Hover over Variables in the Project Explorer panel then click on the

arrow that appears.

Click Add new and the Create a New Variable dialogue box
appears. Type in the name inputl, and click on the ‘OK’ button -
leave the variable type as Byte.

Create variables, input2 and sum in the same way.

Setting up the inputs

Right-click on the top Input icon, and select Properties.

The Properties: Input dialogue box appears.

Double-click on the word Input in the Display name box to
highlight it.

Type ‘Input the first number’ to replace it. This will appear
alongside the Input icon in the flowchart.

(Adding labels like this helps users to understand what is
happening).

Click on the arrow next to the variable box to open the
Variable Manager.

This lists the three variables that you just created.
Double-click on inputl to use this variable in the input box.
Back in the Input Properties dialogue box, click on the down
arrow at the end of the port window and select PORTB to
replace PORTA.

Click on ‘OK’ to close the dialogue box.

Double-click on the second Input icon, (a quicker way to open
the Properties box.)

Configure this input to:

display the label ‘Input the second number’

use the variable input2

use PORTC.

Then close the dialogue box by clicking the ‘OK’ button.

For Arduino users these two Ports will need to be set as follows:
Input 1 set to PORTC (to use the Port A switches on the Combo board).
Input 2 set to PORTD (to use the Port B switches on the Combo board).
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Project explorer == w

=l Globals
—-— Constants
-— <Add new:>
false
-y true
= Variables
o <Add new>

1

x

Objecthandle

)

Bool (either true.

1orfalse.0)

number inthe range 0 to 255)
Int (number inthe range -32768 to 32767)

ange 0to 65535)
2147483648 10 2147483647)

Properties: Input

Display name

Input the first number

Port
PORTB

Variable:

\inputl
Inputfrom:
Single Bit

Entire Port:

Use Masking

Cancel

X

Properties: Input

Display name

Input the second number

Port:
PORTC

Variable:

input2

Inputfrom

Single Bit

Entire Port

Use Masking

x

= Globals
=1~ Constants
—— <Add new>
false
true

3 Bl Variables

— <Add new>
inputl

sum
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Flowcode Example 5 Calculator

Setting up the calculation
e Double-click on the Calculation icon

Properties: Calculation X

Displ
isplay name: 5

to open the Properties dialogue B |- G.s
Calculations: ==
bOX. sum '= inputl + input2 : i"-"?rfli?iztielv>
e Change the Display name: to ‘Add b o
=l Variables
the two numbers together’. L add news>
. . i inputl
e Inthe Calculations box insert: 5 o2
sum = inputl + input2 - ’
0 Cancel

(Either type this in directly, or drag
in variables from the right window
and then insert the = and + signs in the right place)
e Click on the ‘OK’ button, to close the dialogue box.

Setting up the output
e Double-click on the Output icon, to open the output
Properties dialogue box. =

e Click on the arrow next to the Variable box. o

e Double-click on sum to insert it in the box.

e Back at the output Properties dialogue box:
e change the port used to PORTD, (Arduino PORTB)
e click on ‘OK’ to close the dialogue box.

Input the first number

PORTE -=
inputi

Inputthe second number
PORTC -
input2

Adding an LED array

e Click on the Outputs tab and select LED Array
Place it in the middle of the System Panel by moving the
cursor over the component and then clicking-and-
dragging it into position (or right-clicking it and selecting
Centre all objects).

e Click next to the Count property under the Simulation
section on the Properties pane and change the number
of LEDs to seven.

e Click next to the Port property and select PORTD from
the drop-down menu to connect the LEDs to the pins
on port D, (Arduino PORTB).

e Change the colour of the LED array to red (OO00FF)

Add the two numbers together
sum = inputl + input2

sum
-> PORTD

o
c

=
=)

Adding the switches

Two sets of switches are used, one for each binary number. The output port has only eight bits.

The biggest number it can outputis 1111 1111 (= 255 in decimal). We are going to limit ourselves

to inputting seven bit numbers meaning that the biggest number we can inputis 111 1111 (= 127

in decimal). If we used bigger numbers, we would overflow the capacity of the output.

e Click on the Inputs tab, select Switch Array (Slide) and drag it onto the System Panel above the
LED array.

e Open the Properties pane for the Switch Array (Slide). Connect it to port B, using the arrow
next to the Port property to open the drop down menu (Arduino PORTC).

e Add a second Switch Array (Slide) to the System Panel in the

same way. Position it under the LED Array and connect it to ﬁ ﬁ

PORTC (Arduino PORTD).
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Flowcode Example 5 Calculator

Slow simulation
As described earlier, Flowcode allows you to progress through the flowchart one step/icon at a
time, to see the effect of each on the variables and on the output.
e There are three ways to simulate the program step-by-step:
e Click on Run on the Main toolbar and on the Step Into button (Run > Step Into)
e Press the F8 function key on the keyboard.
o Click on the Step Into button on the main toolbar in the simulation section.

Several things happen:
e ared rectangle appears around the BEGIN icon, showing that this is the current step.
e the Simulation debugger window appears (containing Variables and Macro Calls).
e the Variables section lists the three variables that you defined for this program, and
shows their current values (all zero at the moment).

Ignore the Macro Calls section for the moment. ﬁ ﬁ ﬂ

Now set up two numbers on the switch components.
e Move the cursor over the switch box connected to port B.
e Click on switches B0, B1, and B3, to activate them.

You have set up the binary number 000 1011 (= eleven in decimal.)

ﬁ

(Switch B6 gives the most significant bit and BO the least significant bit).

Set up the number 000 1111 (fifteen) on the switches connected to port C.

Now Step Into to the next icon in the program by, for example, pressing F8 once more.

The red rectangle moves on to the next icon, the Loop icon, but little else happens.

Press F8 once again. The red rectangle moves on to the first Input icon.

Press F8 again and the Variables box shows that the inputl variable now contains eleven (the
result of the Input instruction just carried out).

e Press F8 again and the Variables section shows that input now contains fifteen.

e Press F8 again and the calculation is carried out. The sum variable stores the result.

e Press F8 again. The value stored in sum is transferred to the LED array.

It looks like:

Reading from the most significant bit (D6) to the least significant bit (DO), the LED array shows the

number 001 1010. In decimal, this is the number 26. No surprises there then.

e Repeat the same procedure using different numbers and step through the program to check
what the sum of the numbers is.

TIP: Explore adding graphics to your binary calculator to make it easier to read.
Goto > Shapes > Labels to add digits above your LEDs.
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Flowcode Example 6A Microwave

Example 6. Binary logic in control.
Electronic systems can make decisions.

Very often, these are of the form "If this AND this is true, then..." or "If this OR this is true, then...".
They rely on specific combinations of circumstances in order to take some particular action.

They are examples of using binary logic. The answer to the “If...” question is either “Yes” / “No”, or
“True” / “False”, i.e. one of two possibilities (a binary solution). This answer could be expressed as
a logic 0 or a logic 1 and electronically by a high voltage or a low voltage.

There is a class of digital electronic components, called logic gates, that perform exactly these
decisions. The inputs and output are logic O or logic 1.

We can program Flowcode to make exactly the same decisions.

6A. Controlling a microwave oven
For reasons of safety, a microwave oven has a door sensor to
make sure that the microwave generator will not operate if the
door is open. Put another way, the generator operates if the door
is closed AND one of the heating control switches is pressed.

We can build this condition into a Flowcode program.

Setting up the flowchart
Launch Flowcode with a new flowchart.
Create the flowchart shown opposite.
It uses:
e aloopicon

two input icons

three output icons

two decision icons

two calculation icons

a delay icon.

Control switch

Create four variables:

e ‘door’ (to store the state of the door switch).

e ‘control’ (to store the state of the on/off
control switch)

e ‘output’ (to control whether the microwave
switches on or not)

e ‘count’ (to monitor how many times the 1s delay
has occurred. Give it an initial value of ten, so that —
the microwave oven will operate for 9s).

e Use the default configuration for the loop icon.
e Configure one input icon to store the state of the
door switch (on port A bit 0) in the variable ‘door’.
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Flowcode Example 6A Microwave

e Configure the other input icon to store the state of the control switch (on port A bit 1) in
the variable ‘control’.
e The upper calculation icon checks to see whether the door AND the control switch have
been pressed.
Configure it using the equation output = control & door.
The & signifies the AND operation.
The result of this operation (0 or 1) is stored in the variable ‘output’.
e The upper decision icon checks the value stored in ‘output’.
(If output? is shorthand for If output=1?)
Configure this decision icon.

e When the result of the calculation is 0, the program follows the ‘No’ route from the decision
icon and the left-hand output icon is executed. This sends a logic 0 to the LED, ensuring that it
(and the microwave generator) is switched off.

When the result of the calculation is 1, the program follows the ‘Yes’ route. The ‘“Turn on’
output icon sends a logic 1 to the LED turning it on.
Configure both of these output icons.

e The lower calculation icon reduces the number stored in the variable ‘count’ by one.
Configure it using the equation count = count - 1

e The initial value of ‘count’ is ten. Provided the number stored in ‘count’ has not reached zero,
the program follows the ‘No’ route. Eventually, after looping enough times, the number stored
does reduce to zero. The program then follows the ‘Yes’ route and executes the ‘Turn off’
output icon, which is configured in the same way as the other ‘Turn off’ icon, to switch off the
microwave generator.

heating control n n door

output

e Add a switch array to the System Panel. Configure it to have only two switches, one connected
to port A, bit 0 and the other to port A, bit 1.

e Add an LED connected to port B, bit 0 to represent the microwave generator.
e Add labels to the System Panel to identify the components.
Position them using the World coordinates under the Position tab of the label properties.

e Now simulate the program step-by-step, using the F8 function key repeatedly.
e Check what happens for different combinations of switch states and interpret this in terms of

the behaviour of the microwave oven. What happens, for example, if the door is opened while
the microwave generator is operating?

For Arduino the Ports need to be set to PORTC and PORTD (equivalent to A and B on the Combo board).
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Flowcode Example 6B

Example 6. Binary logic in control.

6B Controlling the interior light in a car.
The interior light of a car can be controlled by another Boolean logic
equation.
For simplicity, consider a two-door car with the following behaviour:
The interior light turns on when one door (A) OR the other (B) is
opened and stays on until the ignition switch (C) is turned on.
In Boolean-speak, we say that the light is on if (A OR B) AND NOT C is
true.
Once again, we can build this condition into a Flowcode program.

Setting up the flowchart

Launch Flowcode and start a new flowchart.

Create the flowchart shown opposite, using:
e aloopicon.
e three input icons.
e two output icons. oot A
e a decision icon. I =
e a calculation icon. )

Door B
Al->

Create four variables: door.B

e door_A (to store the state of the switch on door A). Ignition switch
door_B (to store the state of the switch on door B). - o owith

®

e ig_switch (to store the state of the ignition switch).

e output (to control whether the interior light switches
on or not).

Check

e Use the default configuration for the loop icon.

e Configure one input icon to store the state of the switch
on door A (port A bit 0), in the variable ‘door_A’.

e Configure one input icon to store the state of the switch
on door B (port A bit 1) in the variable ‘door_B’.

e Configure the other input icon to store the state of the
ignition switch (port A bit 2) in the variable ‘ig_switch’.

The calculation icon checks to see whether either door
has been opened AND the ignition switch is NOT on.

e Configure it using the equation output = (door_A | |door_B) & lig_switch

The | | signifies the OR operation and ! the NOT operation. The result of the calculation is
stored in the variable ‘output’.

(For Arduino users, please use ports C and D as appropriate).
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Flowcode Example 6B Car

e The decision icon checks the value stored in ‘output’.

e Configure this decision icon.

e When the result of the calculation is 0, the program follows the ‘No’ route from the decision
icon and the 'Turn Off' output icon is executed, ensuring that the light is switched off.

e When the result of the calculation is 1, the program follows the ‘Yes’ route. The “Turn on’

output icon sends a logic 1 to the LED turning it on.
e Configure both of these output icons.

e Add a switch array to the System Panel. Configure it to have three switches, one connected to
port A, bit 0, one to portA, bit 1 and the other to port A, bit 2.

e Add an LED connected to port B, bit 0 to represent the interior light in the car.

e Add labels to the System Panel to identify the components and position them as shown in the
diagram Goto > Shapes > Labels.

Now simulate the program step-by-step, using the F8 function key repeatedly.

Check what happens for different combinations of open doors and ignition switch states.
Interpret the behaviour in terms of the behaviour of the interior light. What happens, for example,
if the door is opened and then closed shortly after? Is this behaviour correct?
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Section 6: Programming
Exercises

The Programming Exercises are presented here as flexible tasks suitable for further
development.

Small, individual tasks can be developed into larger scale projects if desired. Try out the
ideas, test them, experiment, develop your skills and see what you can create.

The aim of the exercises is to develop experience in using Flowcode and in the process,
develop understanding of the programming terminology and techniques it embraces.

Programs can be tested by simulating them in Flowcode, but also downloaded to a
microcontroller and tested on hardware. It is generally assumed that the programmer
is using a Microchip PIC MCU though the exercises are equally applicable to other
microcontrollers.

The section ends with further Challenges. These are even more open-ended and
contain only a brief specification.
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Creating Outputs Exercise 1

This exercise configures Flowcode to output specific digital signals to the LED array.

Background

Section 1 - Introduction to microcontrollers.

Section 2 - Using E-blocks.

Section 4 - Flowcode First Project. Adding digital outputs - Light the LED
Flowcode Wiki - Using masks.

e Change the logic level of a one single pin of a port.

e Send different 8-bit codes to the port of a microcontroller.
Configure an Output icon.

Use binary code.

Manipulate logic output levels.

Use LEDs to display an output.

Compile a program to a microcontroller.

Create a Flowcode flowchart then see if you can:
a) add a single Output icon, configured to light all the LEDs of a port and run the simulation.
b) alter the parameters to light only the odd-numbered LEDs and run the simulation.
c) light only the even-numbered LEDs.
d) light only the high ‘nibble’ bits (4 to 7) of the chosen port.

Modify this program and see if you can:
e) repeat the previous steps using hexadecimal rather than decimal numbering.
f) only light the LED on bit 7, by sending an 8-bit value to the port.
g) only light the LED on bit 7, using the 'single bit' output method.
h) only light the LED on bit 7, using the 'masking' output method.

B Write a program that uses at least twenty Output icons to write different values to port B, one
after the other. Use all four methods in this exercise - hexadecimal, decimal, single bit and mask-
ing. Simulate the program and review the results.

(Save the program and download it to the microcontroller).

TIP: Restart the program a number of times by pressing the Reset button on the
programmer board.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX

73


http://www.matrixtsl.com

Using Delays Exercise 2

In this exercise, you learn how delays are used to slow down program execution. Microcontrollers
work extremely quickly - typically executing about 5,000,000 assembly instructions, every second.
A human can detect and understand only around three stable images per second.

To allow a high-speed microcontroller to communicate with ‘slow’ humans, we sometimes need
to slow it down by adding Delay instructions.

Background

e Section 1 - Introduction to microcontrollers.
e Section 2 - Using E-blocks.
e Flowcode Wiki - Loop icon properties.

Add a delay to slow down execution of a program.
Change the delay interval.

Configure a delay icon.

Control the speed of a microcontroller.

Use an oscilloscope to time events .

Begin by opening the program created in the last exercise (Exercise 1).
a) Add Delay icons and configure them so that the output states can be viewed

comfortably even at ‘HS oscillator’ speed.
b) Save the program and download it to the microcontroller, testing the program on the

E-blocks boards.

Modify the length of the delays caused by the Delay icons.
c) Start with a delay of 1s.
d) Progressively reduce the delay until it is too fast for your eyes to detect the different

output states.
c) Download the program to the microcontroller every time and test it on E-blocks.

d) Use an oscilloscope to measure the delays you set up in Flowcode.

e) Make a detailed drawing of the oscilloscope image, complete with voltage and timing infor-
mation and the delay time used in the Flowcode program.

TIP: Do not test this in simulation mode - simulation timing is not always accurate because it
runs under a Windows operating system and not in ‘real time’.
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Using Connection Points Exercise 3

A Connection Point, or ‘goto’ instruction, is often used to create an infinite loop - to repeat a
set of instructions over and over again (a better way to do this is to use a ‘Loop’ instruction).
The advantage of a Connection Point is that it can be used to jump out of a loop to a certain
location in the program. The idea of pulse-width modulation (PWM) is introduced as a means
of controlling LED brightness.

Background

e Flowcode Wiki - Connection point icon properties.

e Section 1 - Introduction to microcontrollers.

e Section 2 - Using E-blocks.

e Section 4 - Flowcode First Project. Adding digital outputs - Light the LED.

Objectives

Use Connection Points to introduce unconditional branching in a program.
Introduce PWM as a means of controlling the brightness of LEDs.

Create an infinite loop.

Manipulate logic output levels.

Use LEDs to display an output.

Write a program to see if you can:
a) Use Delay, Output and Connection Point icons to light the even and odd LEDs of an array

alternately on and off. Use a 300ms interval between, in an infinite loop.
(Test the program at first ‘step-by-step’ and then continuously in the Flowcode simulator).
b) Use Delay, Output and Connection Point icons to flash the high nibble and low nibble LEDs
alternately on and off, with a 300ms interval between, in an infinite loop.
c) use Delay and Output icons to flash all the LEDs of the array on and off with a 500ms interval
in between, in an infinite loop.
d) Modify the program by changing the ‘on’ and ‘off’ times in such a way that the total
(‘on’ + ‘off’) time is unchanged, e.g. on for 12ms and off for 8ms. What is the difference?
(Download programs to the microcontroller and test them).

TIP: Make the last delays very short and make the on and off times asymmetrical,
(e.g. on for 8ms and off for 12ms).

This is a software PWM generator. When you run it, the intensity of the LEDs is lower.
They flash on and off too fast for our eyes to observe. Instead, we see the intensity change.

D Write a program that:

a) Lights LEDs on the four most-significant bits (MSB), of an array and keeps them on.
b) Dims the intensity of the LEDs on the four least-significant bits (LSB), compared

to the four MSB LEDs, using PWM.
c) Use an oscilloscope to examine the signal controlling one of the four LSB LEDs.

TIP: The MSB is the left-most bit and the LSB is the righ-most bit.
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Performing Calculations Exercise 4

Background

Modern microcontrollers, like the PIC MCU or Arduino, are able to do simple mathematical tasks
with 8-bit numbers at very high speed. As the calculations get more complex or the numbers rise
above an 8-bit value, then the execution time lengthens dramatically. Flowcode allows complex
calculations using up to 16-bit numbers and takes care of all the complexities. However, these may
slow down execution of the program.

Variables - Example 1. Adding digital inputs - Where's the fire?
Flowcode Wiki - Creating variables.

Digital inputs - Example 1. Adding digital inputs - Where's the fire?
Flowcode Wiki - Calculation icon properties.

Section 1 - Introduction to microcontrollers.

Section 2 - Using E-blocks.

Objectives

Create and use a variable.

Configure a calculation icon to perform arithmetic and logic calculations.
Create and manipulate variables.

Perform calculations.

Use LEDs with current limiting resistors.

Create a flowchart that:

a)
b)

©)
d)

e)

f)

uses a variable called ‘counter’ containing an initial value of ‘1’.
displays the value stored in the variable ‘counter’ on LEDs.
(simulate the program to test that it works).

Modify your program by:

adding a Calculation icon to double the value stored in the variable ‘counter’;
displaying this new value on LEDs.
using an infinite loop to repeat these steps continuously with a 300ms delay between them.
What do you see? (This is called a ‘running light’).
replacing the 'multiply by 2" with 'counter = counter + 1'. What do you see now?
(You just programmed a binary counter).

a)
b)
c)
d)
e)

f)

Modify your program to display the result of the following calculations on the LEDs of port B:

45 + 52;

45 AND 52;

45 OR 52;

NOT 45;

(1+3)*(6/2);

VAR2 = VAR1 * 3 (where variable ‘VAR1’ stores the number 18).
(On paper, check if the results are correct).
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Using Loops Exercise 5

Repeating a set of instructions, for an exact number of times, WHILE or UNTIL
a condition is met is one of the most powerful programming operations.

TIP: The slow simulation or 'Step Over' function in the
Flowcode simulator is useful to debug complex programs.

Background

e Flowcode Wiki - Loop icon properties.

Flowcode Wiki - Connection point icon properties.

Flowcode Wiki - Creating variables.

e Section 1 - Introduction to microcontrollers.

e Section 2 - Using E-blocks.

e Section 4 - Flowcode First Project. Adding digital outputs - Light the LED.

Create and use a ‘running light’ program, using the ‘multiply-by-two’ method.
Create and use a ‘running light’ program, using the ‘shift-right’ method.
Create and populate an array.

Create a conditional loop.

Write a program to:

a) make an 8-bit binary counter, using a Loop icon, to count UP from 0 to 255, then reset and
repeat the count (display the counter value on the LEDs of port B).
Modify your program to:
b) make the counter count UP from 0 to 255 and then count back DOWN to O.
TIP: Use two loops inside an infinite loop so that the process repeats indefinitely.
(Download the program to the microcontroller and test it at full speed).

B Do you know KITT From Knight Rider or the Cylon robots from Battlestar Galactica?
Write a program to make a simple ‘running light’ that runs from port B, bit 0 to port B bit 7 and
then back to port B bit 0, repeatedly.

a) Try using the ‘multiply-by-two’” method.

b) Try using the ‘shift right’ method.
Modify your program to create a 16-bit running light, using the LEDs from port A and B.
TIP: Use only loops, no decisions.

(Download the program to the microcontroller and test it).

B Create a flowchart that contains an array of four variables, called ‘Matrix[x]” which stores
the following values: Matrix[0] =129 Matrix[1] =66 Matrix[2] =36 Matrix[3] =24
(Display the outputs on the LEDs of port B).
a) Use two ‘do-while’ loops to create an infinite sequence:
Matrix[0]-Matrix[1]-Matrix[2]-Matrix[3]-Matrix[2]-Matrix[1]-Matrix[0]-Matrix[1]-..... ;
b) Refer to the four variables as ‘Matrix[x]’ where ‘X’ is a separate variable, known as the index
of the array.
(Download the program to the microcontroller and test it).
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Inputting Data Exercise 6

Adding digital inputs to a microcontroller circuit is quite easy but is a big step forward. This allows
external signals to influence how the program reacts.

Background

e Section 1 - Introduction to microcontrollers.
e Section 2 - Using E-blocks.
e Section 4 - Flowcode First Project. Adding digital outputs - Light the LED.

e Input data from switches.
e Use loops to create LED sequences.
e Configure an input icon.

Write a program to show the status of the switches connected to a chosen port, on the LEDs
connected to a different port. eg. when a switch is pressed connected to port A, the corresponding
LED on port B lights.

Modify the program so that:
a) the LED stays lit for 2s.
b) when switch ‘0’ is pressed, LED 1 is lit.
b) when switch ‘1’ is pressed, LED 2 is lit and so on.
c) when switch ‘7’ is pressed, nothing happens.
Explore as many combinations as you can.
(Download programs to the microcontroller and test them).

B Write a program to create a counter that:

a) contains two loops.

b) counts up when switch ‘0’ is pressed.

¢) counts down when switch ‘1’ is pressed.

d) displays the count on the LED array of a suitable port.
(Download programs to the microcontroller and test them).

B Write a ‘running light’ program that:

a) contains two loops.

b) causes the LEDs to ‘run’ left when switch ‘0’ is pressed.

¢) causes the LEDs to ‘run’ right when switch ‘1" is pressed.

d) displays the count on the LED array of a suitable port.
(Download programs to the microcontroller and test them).
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Making Decisions Exercise 7

Earlier programs included simple decision-making, using loops and connection points. Now we
look in detail at the Decision icon, widely known as the ‘if...then...else’ structure, probably the
most widely used command line in any program.

Background

Flowcode Wiki - Decision icon properties.
Flowcode Wiki - Connection point icon properties.
Section 1 - Introduction to microcontrollers.
Section 2 - Using E-blocks.

Objectives

Configure Decision icons and hence add conditional branching to a program.
Control the frequency at which LEDs flash.

Use LEDs to display output logic levels.

Use temporary memory.

Write a program that uses switches to produce a reversed sequence on the LEDs.
a) when switch ‘0’ is pressed, LED 7 lights up.
b) when switch ‘1’ is pressed, LED 6 lights up.
and so on...

Write a program that creates an 8-bit counter, counting from ‘0’ to ‘255’ and then
back to ‘0’ repeatedly.

a) Use Decision icons instead of Loop icons.

b) Use two switches connected to a chosen port, bits 0 and 1.

c) Count up when switch ‘0’ is pressed.

d) Count down when switch ‘1’ is pressed.

e) Display the current count on the LEDs connected to a suitable port.

(Download the program to the microcontroller and test it).

Write a program that counts from O to a value stored in a variable called ‘count’ when switch ‘0’ is
pressed and then waits until switch ‘1’ is pressed before counting down to 0.
a) Use two switches connected to a chosen port, bits 0 and 1.
b) Use a different port for the LED array to display the current value of the count.
(Download the program to the microcontroller and test it).

Write a program that makes eight LEDs flash on and off at a frequency of 1Hz,
i.e. taking one second for an ‘on-and-off’ cycle. Use two switches connected to a suitable port, bits
Oand 1.
a) The LEDs should flash faster if switch ‘0’ is pressed.
b) The LEDs should flash more slowly if switch ‘1’ is pressed.
(Download the program to the microcontroller and test it).
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Making Decisions Exercise 7

Write a program that makes all eight LEDs in an array light when a switch is pressed the first time
and all go off when it is pressed again.
(Download the program to the microcontroller and test it).

A car has two interior lights. One is in the front of the car and one is in the rear.
Write a program to simulate this scenario using LEDs and five switches to control them.
a) Use switches 0, 1, 2, 3 to represent doors being open or closed.
b) Use switch 4 to represent the boot (trunk) being open or closed.
c) Light both LEDs when any door opens.
d) Light only the ‘rear’ LED when the boot (trunk) is opened.
(Download the program to the microcontroller and test it).

TIP: Assume that the switches are closed when the doors are open.
This may be easier to simulate with ‘push-to-make’ switches.

A car’s steering wheel has switches on it that control the external lights. Write a program to
simulate the control of the lights.
a) Use a switch to control the left direction-indicator (choose a relevant LED), which flashes on
for 250ms and then off for 250ms repeatedly until the switch is released.
b) Use another switch to control the right direction-indicator (choose a relevant LED), in the
same way.
c) Use two LEDs as brake lights controlled by a switch which light up for as long as it’s pressed.
d) Create headlights which light when a switch is pressed and stay on until it is pressed again.
e) Finish off with a pair of foglights in the same way.

TIP: Don’t attempt to write this program all at once. Divide it into subsections and solve each
separately before putting them all together.
To make it easier, use the labelling feature of Flowcode to label switches and LEDs.

Six sheep are allowed to wander between two fields.
There are two sensors between the fields. Write a program D0

C»
that counts and displays the number of sheep in each C} 0
C»
C»

represent the sensors.
a) Show the results in binary form on the LED array

field. Simulate this scenario using two switches to
v
g

z Aosuosé

(use four LEDs for the west field and four for the east fie
a) Use two switches to represents the sensors.

TIP: Assume that each sheep is longer than the gap between the sensors.
Think about the various scenarios that could happen. A sheep might trigger a sensor and
then back out. Can a sheep trigger both sensors and then back out? When does a sheep
count as being in the east field?
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Programming LCDs Exercise 8

Using LEDs to display outputs can be limiting.
The LCD is an alternative way to display data, both letters and numbers, for ‘non binary’ humans.

Background

e Section 1 - Introduction to microcontrollers.
e Section 2 - Using E-blocks.
e Example 3. The LCD display - Posting messages

Objectives

e Create, populate and manipulate string variables.

e Control the display of text and numbers on an LCD.

e Use an LCD as an output device for the microcontroller.
e Configure a Component macro for the LCD.

Write a program that displays the text “Hello World” in the centre of the bottom line of the LCD.

i

Write a program that shows an increasing count (decimal) on the LCD screen.
Modify the program so that it counts up when a switch is pressed and counts down when a
different switch is pressed (use Loops or Decisions).

Write a program to show the status of the switches attached to the first port. Every time
a switch is pressed, the corresponding LED of the second port lights up and the value of the

decimal equivalent is displayed on the LCD.

Write a program to show the status of the switches attached to the first port on the LEDs of the
second port and on the top line of the LCD and then:

a) multiply this binary number by 100.

b) display the result on the bottom line of the LCD, with “[x 100 =]” displayed in front of it.

Write a program that scrolls the lines of text given below, one line at a time. Initially, the text is
centred on the bottom line of the display for 2s. Then it moves up to be centred on the top line for
2s, to be replaced on the bottom line by the next line of text, and so on.
Text:

“There are only”

”10 kinds”

“of people”

“Those who”

“understand”

“BINARY”

“and those who”

“DON’T.”
(Enclose the program in an infinite loop and test on the LCD).
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Using the Keypad Exercise 9

A numeric keypad is used in many electronic devices, and in some (eg. mobile phone), it is used as
a numeric keypad and also as a way to type text instead of numbers. There are twelve buttons on
the keypad, yet the keypad is connected to the microcontroller by only eight lines. This problem is
solved by using multiplexing.

Background

e LCD - Exercise 8 - Programming LCDs.
Flowcode Wiki - String manipulation functions.
Section 1 - Introduction to microcontrollers.
Section 2 - Using E-blocks.

Input text and numbers from a keypad and display messages on the LCD.
Use ASCII code to transmit this data.

Use multiplexed inputs.

Configure a Component macro for the keypad.

Display numbers that are pressed on the keypad on the LCD.

a) Display one number one at a time for as long as the button on the keypad is pressed.

b) Can you re-write this program without using the Keypad Component macro?

¢) Extend this program to display numbers that are pressed on the keypad one after
another on the top row of the LCD.

See if you can refine the program to:

d) clear the display when ‘# is pressed.

e) display a maximum of fifteen characters and display a warning on the bottom row of
the LCD when this maximum is exceeded.

Write a program to:
a) add together two numbers les than ‘9999’ entered via the keypad.
b) Display the two numbers, the ‘+’ and ‘=" and the resulting sum on the top row of the LCD.
c) Display a warning on the bottom row when ‘9999’ is exceeded.

Write a program for a simple guessing game, where:
a) a player needs to guess a number between ‘0’ and ‘9’.
b) the secret number is pre-programmed into the microcontroller.
c) the LCD displays, on the top row, the latest guess entered via the keypad.
d) the LCD displays a message, on the bottom row, indicating whether the guess is too high or
too low.
Extend this program so that the secret number is in the range ‘0’ to ‘255’.
Extend the program again so that the secret number is in the range ‘0’ to ‘9999’.

Write a program to use the keypad, as on a mobile phone, to input text to the microcontroller.
a) Use ASCII code to transmit the data.
b) Use the character *’ for a space.
c) Clear the display when ‘#’ is pressed.
d) Display a message on the bottom row when the text has more than ten characters.
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Analogue Inputs and the EEPROM Exercise 10

The 16F18877 PIC MCU accepts 35 separate analogue inputs. Newer devices may have even more.
An analogue signal on one of these inputs can be translated into a 10-bit digital binary number.
We can choose to use only the eight most-significant-bits of this 10-bit number or to use the full
10-bit number. Be aware that working with 10-bit numbers in an 8-bit microcontroller like the PIC
MCU, needs careful program writing.

Background

LCD - Exercise 8 - Programming LCDs
Flowcode Wiki - String manipulation functions
Section 1 - Introduction to microcontrollers
Section 2 - Using E-blocks

Create data loggers, using 8-bit and 10-bit data from the ADC.
Configure an analogue input.

Enter data via switches.

Enter information from light and temperature sensors.
Configure and use the EEPROM.

Scroll through EEPROM data.

Display text and numerical data on the LCD.

Use the E-blocks prototype board.

Write a program to display an 8-bit number, equivalent to the analogue input voltage from the light
sensor on the Sensor board. Try connecting a voltmeter to measure the analogue input voltage.
(Save the following programs and download them to the microcontroller for testing).

Modify the program from Task 1 to display data from the ‘pot’ on the Sensor board.
Try to convert the ADC 8-bit output into a voltage reading between 0 and 5V, making it as accurate
as the 8-bit mode allows. Use a voltmeter to measure the analogue input voltage.

B Modify program 2 to display, on the LCD, a 10-bit number equivalent to the analogue input voltage
from the ‘pot’ on the Sensor board. Use a voltmeter to measure the analogue input voltage.

Try to convert the ADC 10-bit output into a voltage reading between 0 and 5V, making it as
accurate as the 10-bit mode allows. Use a voltmeter to measure the analogue input voltage.

Write a program to monitor the lighting in a room over a 24 hour period:

e using the analogue signal from the light sensor on the Sensor board

e storing light measurements on the EEPROM.

e sampling at the highest rate possible, given that the PIC MCU has 256 bytes of EEPROM
memory on board.

e and displaying each sample with its sample number, on the LCD.

e Dby scrolling forwards through the samples by pressing switch ‘0’ or scrolling backwards by
pressing switch ‘1’.

TIP: Increase sampling rate so that you don’t have to spend 24 hours in testing.
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Using Software Macros Exercise 11

In code-based programming languages, like C and BASIC, a software macro would be called a
subroutine or function or procedure. As programs get bigger, they use certain combinations of
instructions over and over again. These programs become harder to understand and read.
Routines that are re-used can be put into a software macro, which can be called whenever it is
needed in the main program. Making use of these software macros lightens up the main program
and makes it much easier to read.

Background

e Flowcode Wiki - Software macro icon properties
e Section 2 - Using E-blocks

Objectives

Use software macros to simplify the structure of a program.
Create software macros.

Use closed loop control.

Use PWM to control the brightness of LEDs.

Write a program that selects and runs one of three different programs by using two switches.

a) switch ‘0’ selects one of three programs (which you developed earlier).
e ‘X’: an 8-bit binary up-counter, displayed on the LEDs.
e ‘Y’: an 8-bit binary down-counter, displayed on the LEDs.
e ‘Z’: an 8-bit bidirectional ‘running light’, displayed on the LEDs.

b) the LCD displays a text message identifying the selected program.
¢) switch ‘1’ activates the chosen program when pressed.
d) the three programs are placed in software macros.

Modify program 1 so that:
e) If switch ‘0’ is pressed while one of the three software is running, execution stops
immediately and focus returns to the main loop and waits for a new selection.

Modify program 1 again so that:
f) if switch ‘0’ is pressed while one of the three software is running, execution stops and
returns to the main loop, as before, but it stores the value displayed on the LEDs.
g) when the next selection is made, that macro starts the LEDs from where the previous
one left off, making the transition between them smoother.

(Download programs to the microcontroller and test them).
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Using External Interrupts Exercise 12

In earlier exercises, the microcontroller did not necessarily react to inputs straight away because it
was busy doing something else. The external interrupt features of microcontrollers solve this
problem. On a 16F18877, the external interrupts are on pin ‘RBO’ - a single pin interrupt and on
port B as an ‘interrupt on change (IOC)’. If these interrupts are initialized correctly, then a change
on port B can cause the program to stop execution immediately and switch to executing the
appropriate interrupt macro. We then have what is called a ‘real time’ execution.

Background
e Section 2 - Using E-blocks.
e Flowcode Wiki.

Objectives

e Create and use single-pin interrupts.
e Create and use interrupt-on-change (10C) interrupts.
e Use real time operation of a microcontroller.

Write a program to time how many seconds have passed since a program was reset and displays
the result on an LCD. Use a variable called count whose value is displayed on the LEDs (don’t use
an interrupt). Use a 1s delay. A rising edge on pin RBO should call a macro that adds one to count.

Re-design this program using an interrupt (single-pin) on RBO.

Now re-design it using both kinds of external interrupt so that:
a) triggering the single-pin interrupt increments ‘count’ (count = count + 1)
b) triggering the IOC interrupt decrements ‘count’ (count = count - 1)

Write a program to make an electronic dice that:

a) counts from 1to 12.

b) display the result on the LCD.

c¢) starts ‘rolling’ when switch 0 is pressed.

d) stops ‘rolling’ when switch 0 is pressed again.
TIP: The LCD should display numbers from 1 to 12, one after the other, over and over again
rapidly, at 20 ms intervals (much too fast to see with a human eye).

Modify this program so that:
e) the dice keeps ‘rolling’ as long as switch 0 is held down.
f) stops ‘rolling’ when the switch is released.
g) at that point displays the number on the LCD.

Write a program to make a reaction timer that :
a) lights all LEDs initially.
b) keeps them lit for around 6s.
c) switches them off and starts a timer.
d) stops the timer when the player presses switch 0.
e) then displays the resulting ‘reaction time’ on the LCD.
(Use a variable that is incremented every 10ms.)

Modify program 3 to limit the time allowed to the size of the used variable and displays a message
on the LCD when this size is exceeded. (Include a trap to prevent cheating by simply holding down
switch 0 continuously).

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX

85


http://www.matrixtsl.com

Using Timer Interrupts Exercise 13

The other type of interrupt function in Flowcode is the timer interrupt. These allow you to perform
software tasks at precisely predetermined time intervals - a really useful feature when developing
time critical applications and clocks.

Background

e Flowcode Wiki - What is a 7-segment display?
e Section 2 - Using E-blocks.

e Create and use timer interrupt.
e Use the prescaler to create accurate time intervals.
e Trigger the timer using the crystal or an external event.

Timer arithmetic:

The 16F18877 has several timers, but we look at only two: TMRO (Timer 0) and TMR1 (Timer 0).

e TMRO can be triggered by the crystal or by a transition on the TOCKI pin RA4.

e The internal clock has a frequency of crystal clock frequency/4, i.e. 19,660,800/4 =
4,915,200Hz.

e The TMRO prescaler can be set from 1:2 to 1:256. For this exercise, set it to 1:256, so that every
256 clock pulses cause the TMRO to increase by 1. This happens at a frequency of
4.915.200/256 = 19.200Hz.

e Every time this 8-bit timer ‘overflows’ (reaches 256), it generates an interrupt. This happens
with a frequency of 19.200/256 = 75Hz, so that the main program is stopped 75 times per sec-
ond and so the timer interrupt macro is executed 75 times per second.

e Instead of using the crystal, this timer can also be ‘clocked’ by an external event, as when
measuring motor speed etc.

e TMR1 can be triggered by the crystal oscillator or by a transition on the T1CKI pin RCO.

(Its operation is similar to that of TMRO, except that it uses different prescaler values).

Write a program to produce a precise ‘seconds’ timer that displays the result on the LCD and starts
when the microcontroller is reset. Use a 1s delay. Don’t use a timer interrupt.

(Download this program to the microcontroller and test it using your watch).
Rewrite the program using a timer interrupt.

B Write a program to create a basketball timer that starts when switch 0 is pressed and displays the
time elapsed on the LCD. Make the LEDs flash on and off when 30s has elapsed (the time allowed
for the team with the ball to make a goal attempt).
TIP: Use a single-bit interrupt on pin RBO to start the timing.)

B Write a program to produce a precise clock that displays the time elapsed since the last reset, in
hours, minutes and seconds on the LCD (test with a watch).
Modify this program so that:

a) switch ‘0’ stops the clock when pressed the first time.

b) switches ‘1’, ‘2’ and ‘3’ can be used to change the displayed time to the actual time.

c) switch ‘O’ restarts the clock when pressed a second time.

n Write a program to produce a timer that counts down from 01:00:00 to 00:00:00 in seconds and
then lights all the LEDs.
(Download to the microcontroller and test it with your watch).
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Additional Challenges Section 6

Develop a dimmer for all the LEDs that reacts to measured light intensity.

e The light sensor monitors the light intensity in a room. When this intensity drops, a control circuit
sends more power to the lights in that room and vice versa when the intensity increases.

e Use the LEDs to simulate the dimmed lights. This is done by programming a software PWM output to
all LEDs on port B. When the PWM ‘on’ time increases, the LEDs get brighter, etc.

e Put this program in a timer interrupt macro.

e The main loop monitors the analogue input from the light sensor on the sensor board, on port C.
When the light sensor detects less light, the LEDs need to shine brighter. The opposite should happen
with the LEDs when the light level, measured by the light sensor, intensifies.

e The period of the PWM signal stays a constant 20ms at all times, set using a timer interrupt.

e Download this program to the microcontroller and test it. If you have a 2 channel oscilloscope,
measure the analogue input of the light sensor on one and the PWM output to one of the LEDs on
the other.

e Using a similar approach, develop a temperature controller for an incubator. The BL0129 Grove
Sensor board can be used with the Grove Temperature sensor module. Use the LEDs to simulate the
action of a heater.

D Three judges vote on variety acts in a X-factor-like game show. When two or more judges vote ‘Yes’, the act
progresses to the next round.

e Design a program to combine the judges’ votes into a pass/fail verdict.
e C(Create two LED light sequences, one to indicate pass and the other fail.

B Design an automatic watering system for a sealed terrarium (glass plant container). Use the Grove
Temperature and Humidity sensor module to sense when the terrarium needs watering.

e The output device is a motor-driven pump that runs for a set period of time once triggered.
There should be a ‘rest’ period after watering before the system can operate again.

Create a combination lock, using the BL0138 Keypad board to input a four-digit ‘PIN’.
e Add a feature that ‘locks out’ a user after three unsuccessful attempts.
e Modify it to prevent further access to the system for a period of time such as ten seconds.
e Use the LCD display to show the numbers selected on the keypad and the number of attempts made.

Develop a proximity switch for a security light using the Grove Ultrasonic Ranger sensor module. The
system should switch on four lights (12V lamps) when a person approaches within one metre of the sensor
and so makes use of the BLO83 Relay board.

Use the Grove Infrared Receiver sensor module to time the swing of a pendulum without impeding it.

V9 U

Design a system to drive the DC motor (and sensor) on the Actuators training panel at a steady speed.
e Add a feature to modify this set speed.

Design a system to drive the stepper motor on the Actuators training panel so that it rotates, in 15° steps,

through one complete circle and then reverses back to its initial position in the same manner.
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Appendix 1: Arduino
Adjustments
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Arduino Adjustments Appendix 1

ARDUINO: SECTION A

BLO055 Arduino Shield

The board has three ports, labelled A0-A5, DO-D7 and D8-D13.

Port DO-D7 offers full 8-bit functionality.

Port AO-A5 and D8-D13 has 6-bit functionality.

It can be powered from an external power supply, delivering 7.5V to 9V or from a USB supply.

If the Reset switch is pressed, the program stored in the Arduino will restart.

The board is USB programmable via a programming chip. This takes care of communication
between Flowcode and the Arduino device.

The Arduino executes one instruction for every clock pulse it receives.

(Note - a single instruction is NOT the same as a single Flowcode symbol, which is compiled into C
and then into Assembly and probably results in a number of instructions).

This device uses a 16MHz crystal.

The board will detect whether External power supply or USB power supply should be used.

Use of the AVR ISP tool from Microchip via the ICSP header.

Usually supplied with an Arduino Uno device.

Provides power to the downstream E-blocks boards via the port connectors.

Contains the Matrix Ghost chip which allows for real time in-circuit debugging and pin monitoring
when combined with Flowcode.
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Arduino Adjustments Appendix 1

ARDUINO: SECTION B
Selecting Arduino in Flowcode

On opening Flowcode, you are presented with the ‘Welcome’ screen. Click on New Project.

Open Template Launch Help

Templates

~ ==
New Project - Open Project
=]

Select Arduino Uno R3 PDIP.

Project Options *
Choose a Target  Project desoption  General Options  Configure

Choose a targetfor this Sowchart

Famity Free -
- Bl | = ATorsaMrsize .
No chp IC__| m BLooe1

™ EB031
M ECIOARM

B Arduno LiyPad 328
B Ardunc Uno PDIP

Ll Arduno Uno R3 PDIP| H

B Auduno Uno R3 SHD Here the Arduino board has been selected
B Arduno Uno SMD . .
W BLO0SS via the FREE image.
M BL00BS

B MIAC (Ardune-Compatble) System

2 M MIAC (Arduno-Compatibe)

W 16F18877 =

=

5
=

A
=
4]

P

RS

=
=
—

e S

® | oK Cancel

This brings up the standard Flowcode environment. A flowchart can now be developed into a
program that can be tested within the Flowcode simulation mode, or saved and compiled to the
Arduino board.

F
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Y search P Favourtes o Jinputs [J>-Outputs [0 Oiplays (¢ sersors i) conms 8 = S 5 S0 L sustion T e
L e
o
o
A
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1
¢
Loop
‘While
e 1

1
-= PORTC

Follow the Examples and Exercises, taking Port changes into consideration where required.
E.g. Above is how Flowcode First Program (Page 42) would look to an Arduino user.
Here, Arduino users are using PORTC instead of PORTA.

(PORTC on the Arduino ‘Maps’ to PORTA of the Combo board)
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Arduino Adjustments Appendix 1

ARDUINO: SECTION C

E-blocks2:

Eblocks2 uses the ‘Click’ boards for its SPI connections. Using the BL0O106 ‘Click’ board E-block, you can
put the board into the (D8-D13) port as shown in the picture below:

E-blocks1:
Using with the SPI E-block (EB013)

On the SPI E-block move the “CHIP EN SELECTION” jumper to setting “2” and connect DAC_EN and
NVM_EN to the centre pins of the “PORT A MODE SELECT” jumper (J14) of the EBO83 Combo Board:

-

UUGH

o
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Arduino Adjustments Appendix 1

ARDUINO: SECTION D

Setting up the hardware:
This diagram shows you how to set up the E-blocks hardware with Arduino. Plug your Arduino into
the BLOOS55 board as shown, then the combo board into the ports labelled (A0-A5) and (D0-D7).

i)
| &
(]
E
8 |
®

Note: Despite having two hardware port connections between the EB0114 Development board
and the BLOO55 Shield, the Arduino Uno can only provide 6 general purpose I/O connections on
port C, (A0O-A5). Therefore, LEDs ‘6’ and ‘7’ and switches ‘6’ and ‘7’ on Port 1 of the Development
board, cannot be used with the Arduino Uno.

In order to program the Arduino Uno board directly from within Flowcode, you must ensure that
the appropriate drivers are installed. We recommend you visit the Arduino site and download
the latest drivers from there.
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Appendix 2: E-blocks1
Adjustments
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E-Blocks1 Adjustments Appendix 2

E-BLOCKS1: SECTION A

EB006 Multiprogrammer

e The board has five ports, labelled ‘A’ to ‘E “.

e Ports ‘B’, ‘C’ and ‘D’ offer full 8-bit functionality.

e Port ‘A’ has 6-bit functionality, (8-bit if the internal oscillator is
selected).

e Port ‘E’ has 3-bit functionality.

e [t can be powered from an external power supply, delivering
7.5V to 9V or from a USB supply.

e As pointed out elsewhere, no 5V connection is provided in
the D-type connector. This must be provided by an additional
connection to ‘downstream’ boards, using the screw
terminals on the Multiprogrammer board. The ground
connection is provided through pin 9 of the D-type connector.
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IMPORTANT - DO NOT connect the 14V screw terminal to a 5V ‘downstream’ screw terminal.

e |If the Reset switch is pressed, the program stored in the PIC MCU will restart.
e Thereis a 1:1 mapping between pins on the D-type connector and those on the ports, (e.g. Pinl
is connected to PBO, Pin 2 to PB1 etc.)
e The board is USB programmable via a programming chip. This takes care of communication
between Flowcode’ and the PIC MCU.
e The PIC MCU executes one instruction for every four clock pulses it receives.
e (Note - a single instruction is NOT the same as a single Flowcode symbol, which is compiled into
C and then into Assembly and probably results in a number of instructions.)
e This course uses a 19,660,800Hz crystal. The advantages of this frequency include:
e standard Baud rate (19200) is obtainable by dividing it by 1024;
e it can be further divided by 256 to give 75 Hz.
e Jumpers allow the user to select a number of options:
e external power supply or USB power supply;
e where the PIC MCU uses an internal oscillator, all eight bits of port A can be used for 1/0
operation;
e use of an professional ICD2 (In-Circuit Debugger) tool from Microchip.
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E-Blocks1 Adjustments Appendix 2

E-BLOCKS1: SECTION B

EB083 Combo Board
The board combines together on one compact board the
functionality found on a number of individual E-blocks boards:

EBOO4 LED board (x2)

EBOOS5 LCD board;

EBO0O7 Switch board (x2)

EBO0O8 Quad 7-segment Display board.

e For this course, the D-type connectors attach to female
connectors on ports A and B of the Multiprogrammer.

e The board provides a set of eight switches and eight LEDs for
port A and the same for port B.

e With J14 links in the ‘Digital’ position, port A is routed to its push switches (SAO to SA7), to LEDs
(LAO to LA7) and to the quad 7-segment display.

e With J14 links in the ‘Analogue’ position, port A is switched to the analogue sensor section of
the board, so that pin RAQ is connected to the on-board light sensor and pin RA1 is connected
to the potentiometer to give a variable output voltage, (simulating the action of an analogue
sensing subsystem).

e (With these links in this position, the on-board switches and LEDs LAO and LA1 will not
operate.)

e Port B /O pins are routed to its push switches (SBO to SB7), to the LEDs (LBO to LB7), to the
guad 7-segment displays and to the LCD display.

e The quad 7-segment display is turned on by switch S3. It is connected to both port A and B.

e Port B is used to control the LED segments and the decimal point).
e Port A, bits 0 to 3, select which display is activated.

e The LCDis a 16 character x 2 lines module, turned on by switch S5. Normally a complex device

to program, Flowcode takes care of the complexities, unseen by the user.
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E-Blocks1 Adjustments

E-BLOCKS1: SECTION C

Setting up the hardware:

This diagram shows you how to set up the E-blocks hardware.
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E-blocks are built on a bus-based concept. Each E-block D-type connector uses nine pins, allowing

transfer of eight bits of data and ‘ground’.

In the E-blocks system, some E-blocks are ‘upstream’ and some are ‘downstream’. ‘Upstream’
devices have ‘intelligence’, are usually programmable and control the flow of information to
‘downstream’ devices. In the E-blocks system, ‘upstream’ devices connect using 9-way D-type
sockets, whereas ‘downstream’ devices connect using 9-way D-type plugs.

The diagrams show how the pins are numbered on the plugs and sockets. On
both plugs and sockets, bit 0 is delivered on pin 1, bit 7 on pin 8 and pin 9 is

designated 0V.

Where two ‘upstream’ devices need to be connected together a gender
changer or ‘Insulation Displacement Connector’ (IDC) cable with two IDC

sockets on can be used.
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E-Blocksl Adjustments Appendix 2

E-BLOCKS1: SECTION D

Understanding the patch system
Most 'downstream' E-blocks include a patch system that gives you flexibility in the connections
that are made between ‘upstream’ and ‘downstream’ E-blocks. The default connections are
optimized for ease of connection between PIC MCU ‘upstream’ and E-Blocks ‘downstream’ boards.
Other microcontrollers may require different connections, facilitated by the patch system.
The patch system has two parts:
e jumper links that select between default connections and the patch system,
e the patch connectors themselves.
The photographs show an EB090 sensors motherboard with and without sensors attached to it.

The next two diagrams show how to use the patch system on this board.
In the upper diagram, jumpers J12 and J13 are set to the ‘default’ position. This routes signals from
the light sensor and ‘pot’ to pins 1 and 2 of the D-type plug, respectively.

¥ 6000 ¥
60000 i

However, when using a different microcontroller, you might want the signal from the ‘pot’ to
appear on pin 5 of the D-type plug. To achieve this, move jumpers J12 and J13 to the 'patch’
position and add a wire from the ‘pot’ socket on ‘J11’ to pin 5 on J8, as shown in the lower
diagram.

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com IMI-I?IX


http://www.matrixtsl.com

Section: Index

Introduction
AADOUL ThiS COUISE .evvvviiiiiiiiiiiiiitertettetteerrtrereeerrereeraereseseeesearsessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 3
{Vd o Yo YU IRV g =TT PSSR 4
(00101 Y= I Oe ] 1V/=T o o] o 1 6
LEAMNING ODJECTIVES ..vviiiiiiiiiei ittt ettt e e e st e e e st e e e s taeeeesbaeeeeesasteeeesassaeeeessseeessnnssneesannes 8

Mapping to BTEC Level 3 National Extended Diploma in Engineering - Unit 6

Copyright © 2016-18 Matrix Technology Solutions Limited WWW.matrixtsl.com Iﬂﬂl—l?IX

98


http://www.matrixtsl.com
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459684#_Toc464459684
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459684#_Toc464459684
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459684#_Toc464459684
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459684#_Toc464459684
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459684#_Toc464459684
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459686#_Toc464459686
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459686#_Toc464459686
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459686#_Toc464459686
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459686#_Toc464459686
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459686#_Toc464459686
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459687#_Toc464459687
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459687#_Toc464459687
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459687#_Toc464459687
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459687#_Toc464459687
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459687#_Toc464459687
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459688#_Toc464459688
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459688#_Toc464459688
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459688#_Toc464459688
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459688#_Toc464459688
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459688#_Toc464459688
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464459689#_Toc464459689

Introduction to Microcontrollers

Section 1

What is @ MICrOCONTIOIIEI? ..o e et e e e e e e s b e e e s saraeeeesnneeeeas 12
Y ol oToloT g} d o] |1=T oSO PPPPPRRUPPPPPROt 13
The DIGItal WOTI ...t e e e e e e s e e e e e e s e s e nsataeeeeeaeesesanssseaeeeeeeeesnnnnes 14
The ANQIOGUE WOTIA ...t e e e e e e e e e e e e e e s s atr e e e e e e e e sesnnssnaeeeeseeesnnnnnes 14
F Y=Y Lo} (UL - X o T U 15
D F=q 1 | B D | - SRR 15
Analogue t0 Digital CONVEISION ....ciiiiiiiiiieee e e e e e e e e e e s e s s et ae e e e e e e e s esnnnnrnnees 16
Inputting data iNto @ MICIOCONTIOIIET ....coiiiiiiiie e s e s s saee e e e eaes 17
(0101 o 10T un o= F- | - USSP UPTPP 17
LOI8] g ¢=To | 7o 011 PP P PP PP PP PPPPPPPPPPPPPPPPPRt 18
N eI g 1o 7= DT | £ PP PP PP PPPPPPPPPPPPPPPPPPRt 18
TYPES OF IMIBIMOIY ettt ettt e et e e e ettt e e e st a e e e s e aateee e e abaeeeeassaeeeeassaeeeeansseeeesnnssaeesannns 19
Read Only MemOry (ROIM) ..oiiiiiiieeieiiiiee e etee ettt e e et e e et e e s st ee e e s baeeeesensteeeeensaeeeesnssenessnsseeessnnes 19
Random AccesS MEMOIY (RAIM) ...coiiiiiiiee et cett e ettt e et e e e st e e e e s bae e e e sesaaeeeeensaeeeesnsseeaesnsrenessnnes 19
[ (O AV =T o o o] oY A 20
P OB I AMIMIINEG e e 20
The FIOWCOOE PrOCESS ..cocuuviieeiiiiieeeieitiee e ettt ee s ettt e e ettt e e e s tta e e e s esateeeeesasaaeeeesssaeeessssaeeeeassseeeesasssnnesannes 21
RUNNING the PrOSram ..coooeiiiei ettt ettt e et e e et e e e s aae e e e seabteeeesnsaeeeesnssaeassansreaesanns 21
Different types of MICroCONTIOIEY ........eiiiiiiiee e e e e e e e saaee e e eeareeeeenes 22
PICLOFL1887 ArChItECTUIE ...uviiiiiiiiie ettt e e et e e e et e e e s bae e e e seaateeeeenteeeeesnsseeeesnnsreeessnnn 23
PO R T A ittt e et e e e —— e e e e ———e e e e ———ee e e ——eeeeaa——aeeeaha—eeeeaateeeeaatteeeeantreeeeeenrreeeeannns 22
PORT B eeitiiie ettt ettt ettt e e e ettt e e e et e e et e e e e e bt e e e e e a bt e e e e e b atae e e aabteeeseaabteeeeanbteeeeenraeeenaan 22
(2] I OO PP PO PP PPPPRRRPPUPPRNE 22
PORT D cotiie ettt ettt ettt e ettt e e e st e e e s e e bt e e e e abt e e e e e ab et e e e e a bt e e e e e hatee e e aabteeeeeaabeeeeeabbeaeeeenraaeeeann 22
2O I PP PSP PPPPRRRPPUPPRRNE 22
Y T=To o To] o VPP PP PPPPPPPPPR 23
Y PP PP PPPPPP 24
TIMEE L (TIMIRL): oetieiiieeeiie ettt ettt ettt e st e s be e e s be e e s s te e e s stee e ateeensaeesnseeesnsaaesnseeessseesssseeensseennns 24
TIMEE O (TIMIRO): «eeteeiiieeeiie sttt ettt st e st e s e e sabe e e s te e e s atee e sbee e ataeensaeesnsaeesnsaeesnseeesnseesssseeennseenns 24
Y O =T o g T | I LN =Y o VT SRRSOt 25
PORT B EXternal INTeITUPL: oot e e e e e et e e e e e e e e e e aet e e s eeeeeesesnnssaseneeaasessannnes 25
A /D ettt e ettt ee e —e e bt e aate e bt e arte e bt eeate e beearte e teeeaaeebeeaaeeebeenreeebeeaneeeras 25
B U S S S e s 25
INErOAUCTION TO COCKS .oiiiiiiieie et e e st e s s abe e e e e s bbb e e e ssasreeeesanes 25

Copyright © 2016-18 Matrix Technology Solutions Limited www.matrixtsl.com Iﬂﬂl—l?IX

99


http://www.matrixtsl.com
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418515#_Toc464418515
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418515#_Toc464418515
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418515#_Toc464418515
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418515#_Toc464418515
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418515#_Toc464418515
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418516#_Toc464418516
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418516#_Toc464418516
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418516#_Toc464418516
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418516#_Toc464418516
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418516#_Toc464418516
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418517#_Toc464418517
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418517#_Toc464418517
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418517#_Toc464418517
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418517#_Toc464418517
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418517#_Toc464418517
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418518#_Toc464418518
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418518#_Toc464418518
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418518#_Toc464418518
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418518#_Toc464418518
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418518#_Toc464418518
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418519#_Toc464418519
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418519#_Toc464418519
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418519#_Toc464418519
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418519#_Toc464418519
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418519#_Toc464418519
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418519#_Toc464418519
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418520#_Toc464418520
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418520#_Toc464418520
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418520#_Toc464418520
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418520#_Toc464418520
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418520#_Toc464418520
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418520#_Toc464418520
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418521#_Toc464418521
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418521#_Toc464418521
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418521#_Toc464418521
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418521#_Toc464418521
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418521#_Toc464418521
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418522#_Toc464418522
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418522#_Toc464418522
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418522#_Toc464418522
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418522#_Toc464418522
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418523#_Toc464418523
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418523#_Toc464418523
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418523#_Toc464418523
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418523#_Toc464418523
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418523#_Toc464418523
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418523#_Toc464418523
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418524#_Toc464418524
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418524#_Toc464418524
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418524#_Toc464418524
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418524#_Toc464418524
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418524#_Toc464418524
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418524#_Toc464418524
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418525#_Toc464418525
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418525#_Toc464418525
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418525#_Toc464418525
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418525#_Toc464418525
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418525#_Toc464418525
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418525#_Toc464418525
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418526#_Toc464418526
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418526#_Toc464418526
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418526#_Toc464418526
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418526#_Toc464418526
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418526#_Toc464418526
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418527#_Toc464418527
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418527#_Toc464418527
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418527#_Toc464418527
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418527#_Toc464418527
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418527#_Toc464418527
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418528#_Toc464418528
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418528#_Toc464418528
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418528#_Toc464418528
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418528#_Toc464418528
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418528#_Toc464418528
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418529#_Toc464418529
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418529#_Toc464418529
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418529#_Toc464418529
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418529#_Toc464418529
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418529#_Toc464418529
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418529#_Toc464418529
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418530#_Toc464418530
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418530#_Toc464418530
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418530#_Toc464418530
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418530#_Toc464418530
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418530#_Toc464418530
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418530#_Toc464418530
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418532#_Toc464418532
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418532#_Toc464418532
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418532#_Toc464418532
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418532#_Toc464418532
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418532#_Toc464418532
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418533#_Toc464418533
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418533#_Toc464418533
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418533#_Toc464418533
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418533#_Toc464418533
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418533#_Toc464418533
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418534#_Toc464418534
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418534#_Toc464418534
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418534#_Toc464418534
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418534#_Toc464418534
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418534#_Toc464418534
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418535#_Toc464418535
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418535#_Toc464418535
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418535#_Toc464418535
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418535#_Toc464418535
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418535#_Toc464418535
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418536#_Toc464418536
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418536#_Toc464418536
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418536#_Toc464418536
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418536#_Toc464418536
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418536#_Toc464418536
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418536#_Toc464418536
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418537#_Toc464418537
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418537#_Toc464418537
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418537#_Toc464418537
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418537#_Toc464418537
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418537#_Toc464418537
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418537#_Toc464418537
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418538#_Toc464418538
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418538#_Toc464418538
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418538#_Toc464418538
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418538#_Toc464418538
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418538#_Toc464418538
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418538#_Toc464418538
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418539#_Toc464418539
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418539#_Toc464418539
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418539#_Toc464418539
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418539#_Toc464418539
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418539#_Toc464418539
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418539#_Toc464418539
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418540#_Toc464418540
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418540#_Toc464418540
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418540#_Toc464418540
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418540#_Toc464418540
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418540#_Toc464418540
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418540#_Toc464418540
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418542#_Toc464418542
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418542#_Toc464418542
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418542#_Toc464418542
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418542#_Toc464418542
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418542#_Toc464418542
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418542#_Toc464418542
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418543#_Toc464418543
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418543#_Toc464418543
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418543#_Toc464418543
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418543#_Toc464418543
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418543#_Toc464418543
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418543#_Toc464418543
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418544#_Toc464418544
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418544#_Toc464418544
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418544#_Toc464418544
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418544#_Toc464418544
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418544#_Toc464418544
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418544#_Toc464418544
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418545#_Toc464418545
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418545#_Toc464418545
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418545#_Toc464418545
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418545#_Toc464418545
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418545#_Toc464418545
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418545#_Toc464418545
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418546#_Toc464418546
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418546#_Toc464418546
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418546#_Toc464418546
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418546#_Toc464418546
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418546#_Toc464418546
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418547#_Toc464418547
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418547#_Toc464418547
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418547#_Toc464418547
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418547#_Toc464418547
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418547#_Toc464418547
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418548#_Toc464418548
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418548#_Toc464418548
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418548#_Toc464418548
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418548#_Toc464418548
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418548#_Toc464418548
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418548#_Toc464418548
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418549#_Toc464418549
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418549#_Toc464418549
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418549#_Toc464418549
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418549#_Toc464418549
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418549#_Toc464418549
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418549#_Toc464418549
file:///C:/Users/media/Downloads/Microcontroller%20complete%20course%20v3.doc#_Toc464418550#_Toc464418550

Using E-blocks Index

Section 2
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